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Preface

Purpose of the
document

This document describes how to use the features provided in
TechMail™, an electronic mail (e-mail) program for Apple 
Macintosh computers on MITnet, the campus network.  It is 
intended for MIT community members who are new to 
TechMail or e-mail in general.   It assumes basic knowledge 
about using the Macintosh, including Macintosh techniques 
for performing tasks such as copying folders.

What’s new in TechMail
version 2?

TechMail version 21* has incorporated a number of features 
requested by users of TechMail version 1 and some bug 
fixes.  The following is a list of the major changes included in
version 2:

• You can now enclose binary files when you send e-mail 
messages and also receive binary files from other 
TechMail users.   This means you can share 
spreadsheets and graphic files with other TechMail 
users.

• You can send and receive text files longer than 32K 
bytes. 

• Your e-mail address is now @mit.edu rather than 
@eagle.mit.edu .  (Version 1 users:  as of January 1992, 
you can still receive mail addressed to you 
@eagle.mit.edu.  However, this may change in the 
future, so we encourage you to begin using @mit.edu as 
your address.)

• Improvements have been made to the box listing 
window:
◊ You can set TechMail to display the To: field as well as

the From: field in the box listing window.  This option 
can be toggled on and off as desired through a button 
in the User Preferences feature.

1* version 2 refers to TechMail 2.0 and any subsequent versions 
beginning with 2.
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◊ The sender’s real name, when available, is displayed 
in the box listing rather than the e-mail address. 

◊ Rather than having to close a box listing window to 
clear the display of deleted messages, you can select 
“Hide Deleted Messages” from the File menu so they 
automatically disappear from the box listing window. 

◊ You can use arrow keys to move up and down the 
listing and highlight a message.  You can also use 
Shift/arrow to highlight contiguous messages. 

• Writing new messages has been improved:
◊ A Zoom box has been added to the new message 

window.   Zooming the New Message window only 
lengthens it rather than fills the screen thereby 
maintaining the proper width of the mail message. 

◊ You can re-size a new message to be wider than the 
TechMail limit by holding down the option key while 
re-sizing the window.

◊ When you open an e-mail message that you saved as a
draft, it now opens to a standard width of 72 
characters. 

◊ You can use the tab key to format text in a message.  
Also, if you cut and paste text that contains tabs into a
message, or if you insert a file that contains tabs, the 
tabs are preserved as tabs when you send the 
message.

• New reply features have been added:
◊ Now you can choose Reply All from the Local menu 

when you need it rather than setting the Reply All 
feature in User Preferences which causes all replies 
to conform to this option. 
Note:   In TechMail 1.0, if you selected the User 
Preferences option to Reply All, you could either click 
the Reply button in an incoming message window or 
choose Reply from the Local menu to create a reply to
all recipients.  In TechMail 2.0, clicking the Reply 
button will reply only to the person in the From: field, 
i.e., it is not possible to set the Reply button to Reply 
All.

◊ There is also a Reply All with Text feature added to 
the Local Menu.

• Improvements have been made in forwarding e-mail and
replying with text:
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◊ When you use Forward or Reply with Text, the lines of
the original message are kept intact, i.e., the lines 
wrap in the same place as the original message. 

◊ You can now forward multiple messages together in 
the same e-mail message, each separated by an “end 
of forwarded message” line. 

• Improvements have been made to refiling:
◊ The refiling dialog box has been improved.  It 

conforms to the Mac technique of allowing you to type
the first few characters of a box name to select from 
existing boxes.  If you click on new, another dialog box
appears allowing you to create a new mailbox. 

◊ The refile dialog box is larger, showing 14 existing 
mailboxes rather than 9. 

◊ Box names can now be up to 31 characters long.
◊ When you refile a message you’ve just deleted, it will 

be undeleted and refiled in the selected mailbox at the
same time. 

◊ If you modify an incoming message, then refile it, you 
are prompted as to whether you want to save the 
changes. 

• Improvements have been made in printing e-mail 
messages and box listings:
◊ Messages that are up to 80 characters in width retain 

the same format when printed or displayed on the 
screen.

◊ Your name appears, as well as sender’s name, in the 
header of messages you print. 

◊ Tab settings in an e-mail message are preserved in the
printout and handled better on the screen. 

• The Find command has been expanded.  
◊ If you have a box listing window open, you can use the

Find command to either search for an occurrence of 
text in the box listing or in the contents of the 
messages in the list.  

◊ If you have a message open, you can use the Find 
command to search through just the open message or 
through all of the messages in the box in which the 
open message is stored.

◊ The Find command now defaults to searching from 
newest to oldest message.
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• Two types of custom header fields are now provided: 
◊ A header field where you can change the contents for 

each message. 
◊ A static header field that is automatically included 

when you send a message.  Some e-mail users find 
this useful for adding an “address label” to all of their 
outgoing e-mail. 

• When choosing Open Box, the dialog box displays a 
longer list of available boxes. 

• When you use the Get Mail command and the No New 
Mail message is displayed, you can now click on an 
Open Inbox button to open your inbox or you can click 
on OK to take no action.

• TechMail now intelligently maps special characters, 
such as bullets and smart quotes, to standard (ASCII) 
characters when you are writing a mail message. 

• TechMail now handles punctuation within an address 
field better, i.e., if you have (lastname, firstname) in the 
To: field, TechMail will ignore the comma.

• Long lines in the header of a message, including subject 
lines, now wrap to preserve a manageable message 
width on the screen.  

• Carbon copying yourself on all new messages is now a 
blind carbon copy. 

• The Finger command accepts names up to 100 
characters long rather than the previous limit of 39 
characters.

• New menu items have been added:
◊ Retrieve as been added as a menu item under the 

Local menu. 
◊ Open Message has been added as a menu item under 

the File menu. 
◊ You can both send the outbox and get mail at the 

same time by holding down the option key to choose 
Send Outbox/Get Mail from the Server menu.

• Window sizing has been improved:
◊ When you open an incoming message, the window 

automatically opens to the full size of the message 
until it fills the length of your screen.  This way, you 
don’t have to use the scroll bars unless the message is
longer than can fill the screen. 
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◊ If the message has trailing white space in the right 
margin, the window sizes properly ignoring the 
trailing white space.

◊ The scroll bar appears only if a message is longer 
than the window. 

• The zoom box has been improved:
◊ Clicking on the Zoom box when you have a box listing 

window open will cause the window to expand to the 
width of your screen and the length of the listing.

◊ Clicking on the zoom box of the incoming message 
window causes it to re-size just large enough to 
display the whole message, not to fill the entire 
screen. 

◊ Clicking on the zoom box when you are using either 
Directory or Finger will expand the window only as 
large as to hold the text.

• More keyboard equivalents have been added:
◊ Directory: -D ⌘
◊ Expand Addresses: ⌘-E
◊ Select Addresses: ⌘-L 

◊ Check Mail: ⌘-K
◊ Close all windows: ⌘-<option>-W 

◊ Reply with text: ⌘-<shift>-R
◊ Reply all: ⌘-<option>-R
◊ Reply all with text: ⌘-<shift>-<option>-R

• If you have an extended keyboard, you can use the page-
up, page-down, home and end keys when reading a 
message.

• Kerberos and Hesiod support have been added for 
TechMail users at MIT.  There is also an option to turn 
off support.

• (For non-MIT sites) TechMail now uses port 110 rather 
than 109 for accessing the POP server.  

• If you forget to close the Addresses window before 
exiting TechMail, your changes will still be saved.

• TechMail no longer “re-shuffles” the program or mailbox
icons in your TechMail folder after you’ve reorganized 
them. 
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• Improvements have been made in ease of use:
◊ Incoming messages now autoscroll, through use of the

arrow keys. 
◊ If you use the expand addresses feature, you no 

longer have to make sure you capitalize the alias 
name correctly, i.e., expand addresses is no longer 
case sensitive. 

◊ If you are in TechMail and want to use an unformatted
diskette for saving messages, you can format it 
without having to exit TechMail first. 

◊ When you are creating and filing multiple messages to
the outbox, the outbox is dynamically updated. 

◊ When selecting an icon set in User Preferences, you 
can click on either the icon or the radio button.

◊ You can delete empty mailboxes from within TechMail.
• If you use TechMail from the desktop, TechMail can now

find the Help file.
• TechMail is now able to handle minor variations in the 

format of mailbox files, e.g., Babyl files.  This improves 
TechMail 2’s ability to share mailbox files with e-mail 
programs on other systems which use this format.
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How this document is
organized

• Chapter 1, Overview.   Describes the features of TechMail 
and gives installation requirements.  It also gives e-mail 
security tips, administrative procedures, instructions for
forwarding e-mail, changing your password, and what to
do if you decide not to use TechMail.

• Chapter 2, The Basics of TechMail.  Describes how to start up 
TechMail, what the user interface looks like, and how to 
exit TechMail.

• Chapter 3, Reading and Responding to Mail Messages.  Gives 
procedures for checking your mailbox, retrieving 
incoming messages, reading a mail message, responding
to a mail message, saving mail messages, printing 
messages, and throwing out mail messages.

• Chapter 4, Creating and Sending Mail Messages.  Gives 
procedures for writing a message, sending it, saving 
copies of mail messages you’ve created, and 
automatically creating “carbon copies” of your 
messages.

• Chapter 5, Advanced Topics.  Gives advanced e-mail 
procedures for including text from another message, 
adding a text file to a message you are writing, sending 
messages in batches, creating a mailing list, using 
public mailing lists, and for looking up names and 
addresses electronically.

• Chapter 6, Tips and Techniques for Using TechMail.  Discusses 
ways to take maximum advantage of the features and 
flexibility of TechMail, and describes 
e-mail ethics, conventions, and customs.

• Chapter 7, Troubleshooting Procedures.  Describes problems 
that can occur when you are using TechMail and how to 
solve them.  It also gives a list of error messages and 
what to do when you receive them.

• Appendix A, Setting User Preferences.  Describes how to use 
the User Preferences option in TechMail to change 
certain functions of TechMail to suit your needs.

• Appendix B, TechMail Menu Selections .  Lists all TechMail 
menu selections and their functions.
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Conventions used in this
document

The following conventions are used in this document:
<RETURN> Indicates the key on your keyboard that 

executes instructions.
- Indicates the beginning of a set of computer-

related instructions.
Result: Gives the response by TechMail to an 

instruction that you performed.
Bold Indicates input you type into the computer.
Bold italic Indicates computer-input variables you 

replace with a value.

If you need help
If you have any problems or questions regarding the 
installation or use of TechMail, call the Network Help Desk, 
x3-4101 or send e-mail to net-help@mit.edu.  Be sure to 
indicate which version of TechMail you are using, e.g., 2.0.  
If you are not sure of the version number, go into TechMail 
and choose About TechMail from the  menu.

Where to get
documentation

Additional paper copies of both this guide, the TechMail Getting
Started Guide (NS-3), and Upgrading to TechMail Version 2 (NS-16) 
are available free of charge to the MIT community.  You can 
either pick them up in the MIT Computer Connection, W20-
021, or request copies by calling x3-5150 or by sending e-
mail to sendpubs@mit.edu.

Reporting bugs and
making suggestions

If you discover any bugs or have comments about TechMail 
including suggestions for further enhancements, please send
e-mail to 

techmail@mit.edu
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Chapter 1 Overview

Chapter objectives
This chapter gives an overview of the TechMail e-mail 
program for Macintoshes on the MIT campus network.  It 
also discusses the administrative aspects of using e-mail.  
Topics covered are:

• How can I use TechMail?
• Hardware and software system requirements
• Features of TechMail
• What kind of security is provided
• Forwarding e-mail from another address
• Changing your password
• If you decide not to use TechMail

How can I use TechMail?
TechMail provides all the features of a traditional e-mail 
system residing on a central computer, but TechMail lets you
use an e-mail system on your personal computer.  Using 
TechMail, you can:

• Correspond more quickly than with traditional paper 
mail

• Organize and store your correspondence on your Mac, 
making it easier to retrieve and use at a later time

• Send a mail message that includes a file, (ASCII text-
only file) for example, a report or proposal, that you 
created using your word processor

• Use mailing lists you’ve created to send mail messages
• Use public mailing lists to send mail messages
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All mail messages are routed to a central computer called 
the post office server, e.g, eagle.mit.edu2†.  The process is 
similar to renting a post office box.  Your mail messages 
reside on the post office server until you retrieve them.  
Once you retrieve them, they are transferred to your inbox 
on your Macintosh.

Hardware and software
system requirements

To use TechMail, you need the hardware and software listed 
in the following subsections.

Computer hardware
Your computer must be an Apple Macintosh Plus or later 
with a hard disk.

Networking hardware
To retrieve your e-mail from the post office server, you need 
one of the following connections to MITnet, the campus 
network:

• A connection to an AppleTalk network that is connected 
to MITnet via a Shiva Fastpath 4, Cayman Systems 
Gatorbox, or

• An ethernet card and a connection to MITnet
Note: TechMail will not work via a telephone and a modem.  
If you either have an ISDN phone or analog phone and 
modem, you can use TechMail-S.  
If you’re not sure how to determine if you have the right 
equipment and cable, contact your local network 
administrator or computer “expert” for assistance.  If you 
are still unable to find out, call the Network Help Desk, x3-
4101 to find out your options.

Checking to see if you have a connection to MITnet

If you are not sure that your Mac is connected to MITnet, 
contact your local network administrator or computer 

2† Note to version 1 users:  you can now specify your e-mail 
address as @mit.edu rather than @eagle.mit.edu.  As of January 
1992, you can still receive mail @eagle.mit.edu.  However, this 
may change in the future so we encourage you to begin using 
@mit.edu.
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“expert” for assistance.  If you are still unable to find out, 
call the Network Help Desk at x3-4101.
If you find that you do not have a connection to MITnet, 
refer to Connection Alternatives for Macintosh Computers at MIT (DC-5)
for information on the procedures for getting connected.

If your connection to MITnet is different from the requirements

If you discover that you are connected to MITnet in any 
other way than specified above (except telephone and a 
modem), call the Network Help Desk, x3-4101 to find out 
your options.

Computer software
The software you need to use TechMail is:

• Macintosh System version 6.0.5 or later or System 7
• TechMail Program
• MacTCP (an Apple software program that allows 

TechMail to access MITnet)

Checking your System version number

To check which version of the System you are running, start 
up your Mac and open your hard disk.  Double click on the 
System folder to open it and click once on the System file to 
highlight it.  Then choose Get Info from the File menu.  A 
window appears with information including the version 
number.

Getting a current version of the System

If you need to upgrade to a later version of the System and 
have decided not to upgrade to System 7, take four blank 
diskettes to the MIT Computer Connection, W20-021, and 
copy the System software from the Software Upgrades 
server.  Instructions on how to do this are provided next to 
the server.
If you have decided to upgrade to System 7, you can 
purchase the Macintosh System 7.0 Personal Upgrade Kit at 
the MIT Computer Connection in W20-021.  The Kit includes
both the software and System 7 documentation.
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Getting TechMail and MacTCP

If you do not have TechMail, you can obtain it via 
anonymous FTP from net-dist.mit.edu.  To learn how to do 
this, attend one of the Bootstrap classes offered free of 
charge by Distributed Computing and Network Services.  To 
sign up for a class, call the Network Help Desk at x3-4101.  
When you attend the class, you will receive a diskette that 
contains MacTCP and other network-related programs.

Compatibility with other Macintosh software

If you are using NCSA Telnet, SU-MacIP, or TN3270 you 
need to obtain versions of these programs that are 
compatible with MacTCP.  For instructions on how to obtain 
the compatible versions, call the Network Help Desk at x3-
4101.
Also, certain third party Macintosh programs that run 
automatically when you start up your Mac are incompatible 
with TechMail.  If you have trouble using TechMail and you 
use any of these programs, remove them systematically from
your System folder, restart your Mac, and then start up 
TechMail.

Compatibility with System 7

TechMail is fully compatible with System 7.  However, 
MacTCP must be installed in the top level of the System 
folder in order to work with TechMail or any other programs
that use MacTCP.  
Bear in mind that not all Macintosh software is compatible 
with System 7 and may interfere with TechMail.  One known
problem is that Suitcase II version 1.2.8  and earlier 
versions are incompatible with TechMail when the Suitcase 
program resides in the extensions folder of the System 
folder.   To solve the problem, move Suitcase II to the top 
level of the System folder.

Features of TechMail
TechMail lets you do the following e-mail tasks on your Mac 
(For a list of what features have been added to TechMail 
version 2.0, see “What’s new in TechMail version 2.0” in the 
Preface of this guide):

• Check for, send, receive, reply to, and forward mail 
messages
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• Store messages in “boxes” you create and organize on 
your hard disk

• Send messages in batches
• Insert text from another file into a message you’re 

sending
• Print messages on your local printer
• Create your own mailing lists and use public mailing 

lists
• Cut and paste text between windows and other Mac 

programs
• Search through your mail messages
• Access an On-Line Directory which contains e-mail 

addresses of students and staff at MIT

What kind of security is
provided

It is important to distinguish the security that TechMail 
provides and that for which you are responsible.  There are 
four ways in which another person could tamper with the 
mail you’ve sent or received using TechMail.  He or she 
could:

• Monitor the transmission of mail
• Read mail messages stored on your Mac
• Send “counterfeit” mail under your username
• Use TechMail after you’ve given your password

The following sections give brief descriptions on how these 
methods of tampering can affect you.  For more information 
on security in electronic mail, refer to Playing it Safe with 
Electronic Mail (RP-42) available in the MIT Computer 
Connection W20-021.

Monitoring mail transmission 
Mail messages are not protected from tampering during 
transmission.  Currently, messages flow unencrypted (in 
clear text) across the network.  An experienced “hacker” 
could devise a way of monitoring your mail. 
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Reading messages stored on
your Mac

Your incoming and outgoing mail messages reside on the 
hard disk in your Macintosh.  This means that anyone who 
has access to your workstation could locate the inbox and 
outbox and read the contents without having to know your 
password.  Consider this when your send or save 
confidential mail.

Sending “counterfeit” mail
It is possible for someone to send e-mail so that it appears to
have been sent by someone else.  Remember this if you 
receive e-mail that is suspect.

Using TechMail after you’ve
given your password

If you leave your Macintosh unattended after you’ve started 
up TechMail and given your password, someone could use it 
to send mail under your name or read your incoming mail.  If
this is a concern, be sure to exit TechMail before leaving 
your work area.

Forwarding e-mail from
another address

If you were using another e-mail system before you 
purchased TechMail, you may want to have mail forwarded 
from your old e-mail address to your new TechMail address 
until you’ve had time to notify everyone of your new 
address. 
If you decide to use TechMail as your primary e-mail system,
be sure to change your e-mail address in both the MIT 
Directory and the on-line directory.  To do this, fill in the 
Personal Change Notice card on the last page of the MIT 
directory and mail it to the Personnel Office.

Policies on forwarding mail
To have mail forwarded, contact the administrator of the 
e-mail system you were previously using.  Like the U.S. 
Postal Service, the administrator will establish a forwarding 
process, so that any e-mail sent to your old address will 
automatically go to your new address.
The administrator can also inform you of any policies 
regarding forwarded mail, such as length of time that your 
mail will be forwarded.  The following list includes some of 
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the major e-mail systems at MIT and whom to contact about 
having mail forwarded:

• MITVMA.  At the CMS prompt enter the command
tell mailer forward add username at mit.edu
where username is your TechMail username.
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• Sloan School.  Send e-mail to postmast@sloan.mit.edu.   
Give your old e-mail address and your new address.  You
will receive confirmation by return e-mail.

• Athena.   If you have an Athena account and decide to use
TechMail, your TechMail account will be your Athena 
account, i.e., there is no need to forward your e-mail.

 Changing your password
If you forget your password or want to change it, follow one 
of the procedures listed below:

• If you want to change your password and have an 
Athena account, you can do this by logging into Athena, 
since your TechMail password and Athena password are 
one in the same.  To change your password, log into 
Athena and use the passwd command.  For detailed 
instructions on how to do this refer to “Changing Your 
Password” in olh.

•  If you want to change your password and do not have an
Athena account you need to go to the User Accounts 
Office, Room 11-124H.  Call x3-1325, Monday through 
Friday during business hours, to set up a time.

• If you forget your password, you need to go to User 
Accounts, Room 11-124H and reset your password.  Call 
x3-1325, Monday through Friday during business hours, 
to set up an appointment.  Bring one form of photo ID.

If you decide not to use
TechMail

If you’ve been an active user of TechMail and you decide to 
discontinue using it, there are some procedures you may 
need to complete to ensure that people you correspond with 
are aware of your decision.  You might stop using it for one 
of the following reasons:

• You are leaving MIT, either for an extended period, or 
permanently.

• You decide to use a different e-mail system
• You decide not to use e-mail
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Leaving MIT
If you are leaving MIT, either for an extended period or 
permanently, you will want to have your mail forwarded to a 
new e-mail address, or notify colleagues and friends that 
your e-mail address will be closed.

-
1. To forward your e-mail, send e-mail to

postmaster@mit.edu 
and ask to have your mail forwarded.  Give your TechMail 
address, your new e-mail address, and indicate whether 
you will return or are leaving permanently.

Result:   You’ll receive confirmation of forwarding by e-mail.  
2. If you are returning to MIT, contact

postmaster@mit.edu
to have your mail redirected to your TechMail address.  
If you are leaving MIT permanently, your confirmation will 
state the period of time that your e-mail will be 
forwarded.  (Remember that the forwarding process is not
indefinite.)

Choosing another e-mail
system

If you’ve decided to use a different e-mail system, you should
have your e-mail forwarded from your TechMail address to 
your new e-mail address.

-
Send e-mail to postmaster@mit.edu and ask to have your e-
mail forwarded to another system.  Give your TechMail 
address and your new e-mail address.

Result:   You‘ll receive, by e-mail, confirmation of 
forwarding and length of time your e-mail will be for-
warded.  (Remember that the forwarding process is not 
indefinite.)

Deciding not to use e-mail
If you decide to stop using e-mail altogether, you should 
notify everyone who sends you e-mail of your decision.  You 
should also notify the administrator of TechMail that you are
discontinuing it’s use, so your account can be closed.

-
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To notify the TechMail administrator, send e-mail to

postmaster@mit.edu

stating that you plan to discontinue using e-mail.
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Chapter 2 The Basics of TechMail

Chapter objectives
This chapter gives some basic information to help you get 
started with TechMail.  Topics covered are:

• Starting up TechMail
• Setting your username
• Using TechMail from the desktop
• What the user interface looks like
• Entering your password
• Using on-line help
• Exiting TechMail

More advanced topics are covered in Chapters 3, 4, and 5.

Starting up TechMail
Once TechMail is installed on your Mac (see the TechMail 
Getting Started Guide for Macintosh Computers for instructions), it 
resides in a folder on your Mac called the TechMail Folder.  

-
1. Double click on the TechMail Folder to open it.

2. Double click on the TechMail icon.

Result:  The TechMail envelope appears along with the 
TechMail stamp.
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Setting your username
Before you set your username, you have to register to use 
TechMail.  For instructions on how to register, see Section 1,
“Registering for TechMail” in the TechMail Getting Started Guide 
for Macintosh Computers.  To set your username, follow this 
procedure, also discussed in TechMail Getting Started Guide for 
Macintosh Computers:

-
1. Choose User Preferences... from the File menu.

Result:  A dialog box appears with boxes for your username
and your real name. 
Note:  There are other options in this dialog box that you 
can select to change TechMail functions.  For instructions 
on using these options, see Appendix A, “Setting User 
Preferences.”

2. Type your username in the Username box in ALL lower 
case.  Then click once in the Real Name box and type your
name as you want it to appear in mail messages you send.

Note:  When typing your username, do not include your e-
mail address, i.e., username only.

3. Click on the OK button.

Result:  TechMail is set to access the post office server 
using your username.

When you choose any TechMail option that requires your 
username and password, you will be prompted to enter only 
your password.  Also, when you send a mail message, your 
full name will automatically appear in the “From:” field.

Using TechMail from the
desktop

You can move TechMail out of the TechMail folder and use it 
from the desktop.  Each time you start up your Mac,  the 
TechMail icon will appear on your screen outside of the hard
disk.  This makes running TechMail easier because you don’t
have to open the TechMail folder.  To use TechMail from 
your desktop, you must have completed the instructions in 
the preceding section “Setting your username.”

-
1. Double click on the TechMail folder to open it.

2. Move the pointer over the TechMail Settings icon.  Then 
press and hold down the mouse button and drag the icon 
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to the System folder.
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Result: The TechMail Settings file now resides in the 
System folder.

3. Move the pointer over the TechMail icon.  Then press and 
hold down the mouse button and drag the icon to the 
desktop.

Result: The TechMail program now resides outside the 
TechMail folder and on your desktop.
To start up TechMail, double click on the TechMail icon.

What the user interface
looks like

TechMail provides a series of windows and menus that you 
can use to send and receive mail.  Many Macintosh concepts
are incorporated in TechMail, for example:

• Active window:   allows you to click anywhere in a window 
and make it active.

• Size box in the lower-right corner of a window:   allows you to 
change the size of the window.

• Zoom box in the upper-right corner of a window:   allows you to 
expand the window to fill the length of a message, box 
listing, or finger or directory window.   It also allows you
to resize the window to its former size.

• Close box in the upper-left corner of a window:   allows you to 
close the window.

• Scroll bars:   allow you to see more text in the active 
window.

• Selecting multiple items:   allows you to select multiple items
in a window by using the <SHIFT> and  ⌘ keys.  For more 
information on selecting multiple messages, see “How to
select messages” in this chapter.

• Special keys:  If you have an extended keyboard, you can 
use the page-up, page-down, home and end keys to read 
a message.
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TechMail menus
In the menu bar there are six menus from which you select 
TechMail functions to perform e-mail tasks.  The following 
table describes the menus and their purposes.

Menu Lets you...

File Access boxes, print messages and box 
windows, and customize certain TechMail 
functions.

Edit Perform editing tasks on mail messages, 
such as cut and paste.

Local Write or reply to mail messages and maintain
boxes.

Address Create, maintain, and select from mailing 
lists.

Server Send and retrieve mail and electronically 
look up e-mail addresses.

Windows Change the active window.

How mail is filed
TechMail has a feature called “boxes” for storing mail 
messages on your Mac.   Boxes are similar to folders.   
Multiple messages are stored in one box just as multiple 
files are stored in one folder.
TechMail provides an inbox and an outbox.  All your 
incoming messages are transferred to the inbox when you 
retrieve your e-mail from the post office server.  The outbox 
is where you can hold messages you’ve written until you’re 
ready to send them in a batch.
You can also create other boxes in which to organize and 
store incoming messages and messages you’ve written.  For 
example, you could organize messages chronologically by 
creating a box for each month.   Or, you could create a box 
for each project you are working on.  Any mail you send or 
receive regarding that project could be stored in the 
appropriate box.
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What TechMail looks like
You perform all of your e-mail tasks by using four types of 
windows: 

• Box listing window
• New Message window
• Incoming message window
• Addresses window

Box listing window

A box listing window appears either when you choose Get 
Mail from the Server menu or Open Box from the File menu.
If you choose Get Mail, the inbox window appears.  If you 
choose Open Box, you then specify which box and the box 
listing window appears for the selected box.  The box listing 
window lists all mail messages in the opened box.

If the list of messages exceeds the size of the screen, the 
bottom of the list is displayed.  The number of messages is 
at the top of the screen.  
An icon appears to the left of each message.  It is one of the 
following types:

Indicates an incoming mail message that you’ve
read.
Indicates an incoming mail message that you 
have not read.
Indicates an new message that has been 
created and filed in a box.
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Indicates a new message that was previously 
created and filed in a box.

Indicates a mail message that you’ve deleted.

There are two buttons in a box window that you can use to 
issue commands.  They are the same commands that appear 
under menus, but are also provided here for convenience.  
The following table gives the buttons and their functions:

Button Function

Delete Throws out the mail message.

Refile Allows you to file a message in a different 
box.

New Message window

When you choose New Message from the Local menu, the 
New Message window appears.  It contains a blank mail 
message which you fill in.  (See “Writing a mail message” in 
Chapter 4 of this guide for instructions on how to create a 
mail message.)

There are several buttons in the New Message window that 
you can use to issue commands.  They are the same 
commands that appear under the menus, but are also 
provided here for convenience.  The following table gives 
the buttons and their functions:
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Button Function

Send Sends the  mail message.

Save Draft Allows you to save a draft of your mail 
message.

Outbox Allows you to accumulate messages you’ve 
created and send them all at one time.

Expand Inserts e-mail addresses of recipients whose 
names appear in the header and who are included 

in your e-mail address book.  (See “Creating your 
own personal mailing lists” in Chapter 5 of this 
guide for more information on e-mail 
address books.)

Incoming message window

An incoming message window appears when you choose a 
mail message to read by double clicking on an envelope 
icon.  It contains the contents of the incoming mail message.
The sender’s name is at the top of the window.
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There are several buttons in the window that you can use to 
issue commands.  They are the same commands that appear 
under menus, but are provided here for convenience.   The 
following table gives the buttons and their functions:
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Button Function

Delete Throws out a mail message.  When you click 
on Delete, an “X” appears next to the entry of 
the deleted message in the box window.

Refile Allows you to file a mail message into a 
different box.

Forward Creates a message containing the text from 
the incoming mail message you were just reading, 

i.e., the active window.

Reply Creates a blank mail message addressed to the 
sender of the incoming mail message you 

were just reading, i.e., the active window.

Addresses window

The Addresses window appears when you choose Edit 
Addresses from the Address menu.  It is where you can 
create and maintain your list of recipients and their e-mail 
addresses.
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How to issue commands
There are several ways to issue commands in TechMail.  You
can use either the mouse and choose a command from a 
menu, or use the keyboard and issue commands with 
keystroke combinations (See Appendix B, “TechMail Menu 
Selections” in this guide for keyboard equivalencies).  
Commands that are frequently used with certain tasks are 
included as buttons in the window in which you are working 
(see, “What TechMail looks like,” in this chapter, for 
information on these commands).

How to select messages
Many of the TechMail commands can be used with either 
one message or multiple messages.  For example, you can 
delete more than one message at at time.  The following 
table describes ways to select messages in a box listing 
window:

To select... Action

One message Click once on the message

Messages 
grouped together

Hold down <SHIFT> and either click on 
each message or press the up or down
arrow key

Messages not 
grouped together

Hold down the ⌘ key and click on 
each message

To de-select messages, click under the last entry in the box 
listing.

Entering your password
When you use TechMail commands that involve the use of 
your TechMail account or username (e.g. Check Mailbox, 
Get Mail, or Send), you are prompted for your password.  
Type your password exactly as you entered it, either when 
you filled in your TechMail registration form or when you 
registered for your Athena account.  TechMail checks for 
upper and lower case.
If you’ve been running TechMail, with your password 
entered, for more than eight hours and choose Check 
Mailbox, Get Mail, or Send, the message “Authentication 
failed: tickets expired” appears.  This is a function of 
Kerberos authentication.  Click on the Try Again button and 
you will be prompted for your password.
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Using on-line help
On-line Help describes the functions of TechMail.  You can 
use Help at any time during the TechMail session.  To access
Help,

-
1. Choose Help from the File menu.

Result:  A window appears displaying the beginning of the 
Help file.

2. To find a specific topic, choose Find from the Edit menu.  
Enter a topic in the Find String box.  Click once on the 
Case Sensitive check box if you want to match exactly what 
you entered, i.e, upper- and lowercase.

Result:  The Help file will scroll to the first occurrence of 
the topic.
To search further through the file for the same topic, 
choose Find Next from the Edit menu.

3. To browse through the Help file, use the scroll bar.

4. To exit Help, click once on the Close Box.

Exiting TechMail
To exit TechMail,

-
Select Quit from the File menu.
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Chapter 3 Reading and Responding 
to Mail Messages

Chapter objectives
This chapter gives instructions for reading and responding 
to mail messages.  Procedures are given for:

• Checking your mailbox
• Retrieving incoming messages
• Reading mail messages
• Responding to mail messages
• Forwarding mail messages
• Saving mail messages
• Printing mail messages
• Printing a box listing
• Deleting mail messages
• Retrieving deleted messages

Checking your mailbox
To check your mailbox for new messages, but not to retrieve 
them,

-
Choose Check Mailbox from the Server menu.

Result:  (A message may appear if you haven’t entered 
your password or entered it over eight hours ago.  See 
“Entering your password” in Chapter 2 for more 
instructions.)  A screen appears telling you how many 
messages you have in your mailbox on the post office 
server.
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Retrieving incoming
messages

When you retrieve incoming mail messages, TechMail takes 
your incoming mail waiting for you on the post office server 
and transfers it to the inbox on your Macintosh.
Note:  Once you’ve retrieved mail messages from the post 
office server, they are stored in your inbox and erased from 
the server.
To check your mailbox and retrieve your new messages,

-
Choose Get Mail from the Server menu.

Result:   (A message may appear if you haven’t entered 
your password or entered it over eight hours ago.  See 
“Entering your password” in Chapter 2 for more 
instructions.)  The inbox window appears with the listing 
of new messages you retrieved along with any other 
messages still in your inbox.

If you have no new mail messages, a message appears on 
the screen informing you of this.  If you want to open the 
inbox window anyway, click on the Open Inbox button.  
Otherwise click on OK.

Note:  If you have an Athena account and use Athena mail as 
well as TechMail, remember that once you use TechMail to 
retrieve your messages, they are deleted from the post office
server and you will not be able to retrieve the same 
messages with Athena mail.
However,  if you use Athena mail to retrieve your messages, 
you can retrieve them and leave a copy on the post office 
server.  To do this, at the Athena prompt type,

inc -notruncate
You can then retrieve the same messages with TechMail.
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Reading mail messages
To read a mail message, you must have your inbox open.  
(See the previous section, “Retrieving incoming messages.”)

-
Double click on the envelope icon next to the mail 
message you want to read or click once on the message 
and press <ENTER>.

Result:  A window appears with the mail message 
displayed.  The title of the window is the username of the 
sender.
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Note:   If you receive a message larger than 32K bytes and 
try to open it, TechMail will display a dialog box asking 
you if you want to save it as a text file or open the first 
32K bytes of the message.  Click once on the Save as text file
button, enter a name, then click on the Save button.  You 
can then open this text file using your word processing 
program and read the full message (you can’t open and 
read the text file in TechMail).  The original mail message 
is still in your Inbox so you can still open the first 32K or 
use it for a reply.

Responding to mail
messages

When replying to a message you can either reply to the 
sender only, or to all recipients of the original message.  
Also, you can either include text from the original message 
or leave it out.  To reply to an incoming mail message, you 
must have the message open.  (See the previous section, 
“Reading mail messages.”)
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-
1. Choose one of the following types of replies:

Type of reply Action
Reply to the sender only 
and omit the text

Click once on the Reply 
button or press ⌘-R

Reply to the sender only 
and include the text

Choose Reply with Text 
from the Local menu or 
press -<shift⌘ >-R

Reply to all recipients and
omit the text

Choose Reply All from 
the Local menu or press  

-<option⌘ >-R
Reply to all recipients and
include the text

Choose Reply All with 
Text from the Local menu
or press 

-<shift>-<option⌘ >-R

Result:  A window appears with the header information 
filled in.  If you selected Reply with Text or Reply All with 
Text, the original message appears in the window with 
space below for your reply.  Notice that each line of the 
text from the original message is preceded by a “>.”

9117

If you click on Reply, the message area is blank.
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2. Type the text of the message.  To send the message, click 
once on the Send button.

Result:  A message appears stating that your message is 
being sent.

Forwarding mail
messages

You can forward one or more mail messages to another e-
mail address either from the incoming message window or 
from the box listing window. 

-
1. To forward one message from the incoming message window, click 

once on the Forward button.

To forward one or more messages from the box listing window, 
select the message, or messages, you want to forward 
then choose Forward from the Local menu.
Result:  A window appears with a header that includes your
e-mail address in the “Subject:” field and the entire 
original mail message.  If you are forwarding multiple 
messages, each message is separated by an “End of 
Forwarded Message” line.
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2. Fill in the rest of the header information.  (For 
instructions on how to fill in the header field, see “Writing
a mail message” in Chapter 4 of this guide).  If you want 
to add text to the message, you can position the cursor 
anywhere in the text of the message and start typing.

3. When you are finished, send the message by clicking once
on the Send button.

Saving mail messages
Any mail message you want to save can be filed in a box that
you create.  Messages can be saved as is, or you can edit 
them and then save them.  You can save a message from 
either the inbox window or an incoming message window. 
(For instructions on saving multiple messages at one time, 
see “Refiling messages” in Chapter 4 of this guide.)
Note:  If you do not save a message, it will remain in your 
inbox until you delete it.  (See “Deleting mail messages” in 
this chapter.)  Storing a large number of mail messages in 
your inbox will cause TechMail to function more slowly.  

-
1. To save from the inbox window, click once on the mail 

message to highlight it, then click once on the Refile 
button.

To save from an incoming message window, click once on the 
Refile button.

Result:  A dialog box appears prompting you to select a 
box.

2. Choose  an action:
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• If you already created a box that you want to use, double 
click on the box name. 
Result: The dialog box closes and the message is filed

• If you want to create a new box,  click once on the New button.
Result:   A dialog box appears prompting you for the 
name of the new box.

Type the name of the box and click once on the save 
button.
Result:  Both dialog boxes close and the message is filed.

If you refiled from the incoming message window, the 
window closes and the inbox window appears.
An “X” appears next to the mail message you’ve just 
saved, indicating that it has been filed into the specified 
box and is marked for deletion from the inbox.

Modifying messages and
saving them

You can make changes, such as adding or modifying text, to 
any incoming messages before saving them.   To make 
changes, you must have the message open in the incoming 
message window.

-
1. After making all of your changes, click once on the Refile 

button.

Result:  A dialog box appears prompting you for a box 
name.

2. Save the message, as described in the previous 
procedure.
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Result: A dialog box appears prompting you to save 
changes.

3. Click once on the yes  button.

Result: The message is filed, along with your changes, the 
incoming message window closes, and the inbox window 
appears.

Note:  If an incoming message has tabs in it and you modify 
the message in any way, the tabs will be converted to spaces, 
i.e., the number needed to preserve the formatting created 
by the tabs.  

Printing mail messages
You can print mail messages from either a box listing 
window or you can print a message that is open in an 
incoming message window.

To print from the box listing window,
-

1. Select the message or messages you want to print, then 
choose Print from the File menu.

Result:  The Print Dialog box appears.  This is the standard
Macintosh Print Dialog box.

2. Change the settings to those you want, then click on OK.

Result:  The mail message prints on your local printer.

To print an open message in an incoming message window, 
-

1. Choose Print from the File menu.

Result:  The Print Dialog box appears.  This is the standard
Macintosh Print Dialog box.

2. Change the settings to those you want, then click on OK.

Result:  The mail message prints on your local printer.
TechMail automatically inserts page breaks in messages that
are longer than one page.  A header at the top of each page 
contains the sender’s name, the subject, the date the 
message was sent, your name, and the page number.
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Quick way to print
If you want to bypass the dialog box, you can use the 
following technique for printing:
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-
Press -P ⌘ (the keyboard equivalent for the Print 
command) then press <RETURN>.

Printing a box listing
You can also print the list of messages in a box.  To do this, 
you must have the box listing window open and active, and 
no messages in the listing can be selected.

-
1. Click once after the last message to deselect all messages.

2. Choose Print from the File menu.

Result:  The Print Dialog box appears.  This is the standard
Macintosh Print Dialog box.

3. Change the settings to those you want, then click on OK.

Result:  The list of mail messages in the box prints on your 
local printer.

Deleting mail messages
You can delete mail messages from either a box listing 
window or you can delete a message that is open in an 
incoming message window.

To delete from a box listing window,
-
Select the message or messages you want to delete, then 
click once on the Delete button.

Result:  An “X” appears next to the entries of the deleted 
messages in the box listing window.

To delete an open message in an incoming message window,
-
Click once on the Delete button.

Result:  The incoming message window closes and an “X” 
appears next to the entry for the deleted message in the 
box listing window.
Any entries marked with an “X” will remain in the box 
listing window until you close the window or exit 
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TechMail.  After you exit, the entries marked for deletion 
are thrown out.
You can retrieve messages marked for deletion before you 
close the box listing window or exit TechMail.  See the 
following section, “Retrieving deleted messages”.
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Hiding deleted messages
You can set TechMail so that deleted messages are not 
displayed in the box listing window.  To do this,

-
Choose Hide Deleted Messages from the File menu.

Result:  When you delete messages from the box listing 
window, they are no longer displayed on the screen.
To show deleted messages, choose Show Deleted 
Messages from the File menu.

Retrieving deleted
messages

If you delete a mail message and then change your mind, 
you can retrieve it in one of the following ways:

• Retrieve a message from the inbox window
• Open a deleted message and retrieve it
• Refile a message from the box listing window

Note:   These methods work only as long as you have not closed 
the box listing window or exited TechMail.  Once you’ve either closed
the window or exited TechMail, all messages marked for 
deletion are thrown out and you can’t get them back.

Retrieving a message from
the inbox window

If you have a box listing window open and active and want to
retrieve a deleted message, select the message, then

-
Choose Retrieve from the Local menu.

Result:  The “X” that marked the message as deleted is 
replaced with the envelope icon (or the dot icon if you 
have chosen it in User Preferences) and the message is 
restored to the mailbox.

Opening a deleted message
and retrieving it

You can also open a message first before retrieving it.  This 
technique of retrieving is useful when you want to look 
through the message before deciding to save it.  To do this,

-
1. From the inbox window, double click on the message you 
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deleted and want to retrieve.

Result: A window appears with the message displayed.
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2. Click once on the Retrieve button.

Result:  The Retrieve button is replaced by the Delete button.

3.  Click once on the Close box to close the message.

Result: The inbox window appears.  The “X” next to the 
message you retrieved is replaced with an open envelope 
icon.

Refiling a message from the
box listing window

If you want to retrieve a message and store it in another 
box, you can use the refile command which will both 
“undelete” the message and refile it at the same time.

-
1. From the box listing window, click once on the message 

you deleted and want to retrieve, to highlight it.

2. Click once on the Refile button.

Result: A dialog box appears prompting you to select a box.

3. Select a box in which to refile the message, or create a 
new box (for detailed instructions on refiling, see “Saving 
mail messages” in this chapter).

*See “Handling Difficult Errors” following this section



Chapter 4 Creating and Sending 
Mail Messages

Chapter objectives
This chapter gives instructions on topics related to creating 
and sending mail messages.  Procedures are given for:

• Writing a mail message
• Saving a draft
• Sending a mail message
• Automatically saving copies

Writing a mail message
To write a mail message, 

-
1. Choose New Message from the Local menu.

Result:  The New Message window opens, displaying a 
blank message form.

2. Fill in the header information.  To move down from one 
header field to another, press <TAB>, to move up, hold 
down <SHIFT> and press <TAB>.  You can also click once in a 
field to fill it in.   Follow the instructions below for filling 
in the header.
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Header fields
“To:”  Type the e-mail address of the person to whom you 
want to send the mail message, for example, smith@mit.edu.  
To send a mail message to more than one address, separate 
each name and address with a comma followed by a space.  
For example, 

joe@mit.edu, fred@mit.edu 

If you need another line to add more addresses, press 
<RETURN>.
“Cc:”  If you want to send a copy to someone else, type in his
or her e-mail address.  To send a mail message to more than 
one address, separate each address with a comma followed 
by a space.
“Bcc:”  If you want to send a blind carbon copy, type in the 
electronic address of the person to whom you want it sent.
“Fcc:”  This field appears only if you use the File Copy to 
function in the User Preferences.  By using this function, you
can either specify a box in which you want to automatically 
file a copy of all mail messages you create or you can enter a
box name in the “Fcc:” field each time you create a mail 
message.  See  “Automatically saving copies” in this chapter 
for instructions on how to use the File Copy to function.
“Subject:”  Type the subject of the mail message.

About e-mail addresses...

Electronic mail addresses include the username of the 
addressee and the host name, i.e., the destination.  For 
example, 

cosby@sloan.mit.edu
is the address of user “cosby” on the computer 
eagle.mit.edu.  As a TechMail user, your e-mail address is 
username@mit.edu, where username is the username you chose 
when you registered to use TechMail.
It is recommended that you include the addressee’s real 
name with their e-mail address.  For example,

cosby@sloan.mit.edu (Joe Cosby)
Some e-mail systems, such as TechMail, make use of this 
additional information, if available, to make e-mail listings 
and messages clearer.
To find someone’s e-mail address use the Directory command.  
For instructions on using this command, see “Electronically 
looking up names and addresses” in Chapter 5 of this guide.
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Editing text
Press <TAB> or click once in the text area and type the text of
the mail message.  When you reach the end of a line, 
continue typing and the text will automatically wrap to the 
next line.  
Under the Edit menu, you can use the Cut, Copy, and Paste 
commands as you would in your word processing program. 
You can use the tab key to format text; TechMail has tab 
stops every 8 spaces.  Rather than using the tab character, 
TechMail inserts spaces, the number needed to retain the 
formatting that you created with tabs in the message.  This 
way, the formatting is retained regardless of the kind of e-
mail program that the recipient uses to read his or her mail.
If you want a larger window to write in, click once on the 
zoom box.  This will lengthen the window and leave the 
width the same.

Printing a new message
You can print a new message at any time while you are 
creating it (for instructions on how to do this, see “Printing 
Mail Messages” in Chapter 3 and follow the procedure for 
printing a message from an incoming message window).  
Bear in mind that when you print a new message, the line 
breaks may not be the same as they appear on the screen.  

Saving a draft
To save a draft of a mail message you’ve begun writing, but 
are not ready to send,

-
Click once on the Save Draft button.

Result: The message is saved in a box that is automatically 
created by TechMail, called Draftbox.
You can save as many drafts as you want in the Draftbox.  
Each draft is filed by the date it was created.

Retrieving a draft
To retrieve a draft, you need to open the Draftbox by using 
Open Box from the File menu.  See “Opening boxes” in 
Chapter 5 of this guide.

Sending a mail message
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To send a mail message,
-
Click once on the Send button in the New Message 
window.
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Result:   (A message may appear if you haven’t entered 
your password or entered it over 8 hours ago.  See 
“Entering your password” in Chapter 2 for more 
instructions.)  A message appears stating that the 
message is being sent.
Note:   If your mail message is not delivered, for example 
because of a typographical error in the address, you will 
receive a mail message to that effect the next time you 
retrieve mail.  If you continue to have problems sending 
mail and have determined that the address is correct, call 
the Network Help Desk, x3-4101.
If you are planning to create and send several messages 
at one time, rather than sending each one separately, you 
can create each message, hold it in the outbox, then send 
them all at once.  See “Sending messages in batches” in 
Chapter 5 of this guide.

Automatically saving
copies

To automatically save copies of all your outgoing messages, 
-

1. Choose User Preferences... from the File menu.

Result:  A dialog box appears with a box for you to specify 
where you want to store a file copy of your outgoing mail 
messages .
Note:  There are other options in this dialog box that you 
can set that affect TechMail functions.  For instructions on
how to use these options, see Appendix A, “Setting User 
Preferences” in this guide.

2. Click once on the File Copy to check box and type the name 
of the box you want to use.

If you prefer to specify different boxes depending upon 
the message, leave the File Copy to box blank.  When you 
create a mail message, type the box name in the “Fcc:” 
field.

3. Click on the OK button.

Result:  Each time you send a new mail message, a copy of 
it will automatically be filed in the box you specified.
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Chapter 5 Advanced Topics

Chapter objectives
This chapter gives instructions for several advanced 
procedures.   Procedures are given for:

• Creating and opening boxes
• Opening multiple mail messages
• Searching through mail messages
• Refiling messages
• Saving a message as a text file
• Including text from another message
• Including a text file with a new message
• Including binary files with a new message
• Extracting binary files from an incoming message
• Sending messages in batches
• Creating your own personal address book
• Using and creating public mailing lists
• Electronically looking up names and addresses

Creating and opening
boxes

As described in the section “How mail is filed” in Chapter 2 
of this guide, you can create boxes in which to store 
incoming mail messages.  This function gives you the 
flexibility of organizing saved messages in different boxes 
and categorizing them however you want, for example, by 
project, name of sender, or by date. 

Creating boxes
You create a new box when you refile a message.  To do this,

-
1. From an incoming message window, click once on the 

Refile button or select Refile from the local menu.

Result:  A dialog box appears prompting you for the name 
of a box.
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2. Enter a name for the box, then click once on the New 
button.

Result:  The dialog box closes and the message is filed in 
the box.

3. Click once on the Close box to close the message.

Result:  A box listing window appears.  The message you’ve
refiled has an “X” next to it indicating that the message 
has been refiled in the specified box and it is marked for 
deletion.

Opening boxes
You can open boxes to re-read messages or copy contents 
from an old message into a new message.

-
1. Choose Open Box from the File menu.

Result:  A dialog box appears listing the existing boxes.  

2. Double click on the box you want to open.

Result:  A box listing window appears for the box you 
selected.
You can open messages to read or use the standard 
Macintosh Cut, Copy, and Paste features to copy contents 
from stored message into a new message you are 
creating.
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Opening multiple mail
messages

From a box listing window, you can open more than one mail
message at a time.  To open multiple messages,

-
1. Select the messages you want to open (for instructions on 

selecting multiple messages, see “How to select 
messages” in Chapter 2 of this guide.)

2. Double click on any selected message or press the <enter> 
key.

Result: A window opens for each selected message.  The 
windows are stacked in an offset fashion.

Searching through mail
messages

There are two ways you can search through mail messages 
in TechMail.  You can either search through a box listing to 
find a particular message or messages, or you can search 
through the contents of one message or the contents of all of
the messages in a mailbox  Here are some guidelines for 
how to choose a method of searching:

• If you want to find a message or group of messages from
a particular person, search through the box listing.

• If you want to find a message sent to you on a certain 
date, search through the box listing.

• If you want to find message(s) about a particular topic, 
search through the contents of messages in a mailbox.

• If you want to find a section within a message that deals 
with a particular subject, search through the contents of
the message.

Searching through a box
listing

Use this procedure to search through the list of messages in 
a particular box.  To do this, you must have the mailbox open
and nothing selected, i.e., no messages in the list can be 
highlighted.

-
1. Choose Find from the Edit menu.

Result: The Find dialog box appears
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2. Fill in the dialog box:

• Type a string of characters that appear in the message 
or messages you want to find.

• If distinguishing between upper and lower case 
characters is significant for the search, click once on the
Case Sensitive check box.

• If you want the search to begin with the oldest message 
(the default search order is to begin with the newest 
message), click once on the Search Oldest First check box. 

3. Click once on the Find button.

Result:  The first entry in the box listing that contains the 
string of characters is highlighted.
If there is no match, the computer beeps.

4. If you want to find the next occurrence of the text, press 
-G⌘  or choose Find Next... from the Edit menu.

Result: The next entry in the box listing that contains the 
string of characters is highlighted.

5. Repeat step 4 until you have located what you need or 
until the computer beeps indicating that the entire box 
listing has been searched.

6. To open the messages, double click on any selected 
message.

*See “Handling Difficult Errors” following this section



Searching through message
contents

Use this procedure to search through the contents of one 
message or the contents of all of the messages in a mailbox.
To search through the contents of one message, the message must be 
open and active.
To search through the contents of all messages in a mailbox, the box 
listing window must be open. 

-
1. Choose Find from the Edit menu.

Result:  The Find dialog box appears.

2. Fill in the dialog box:

• Type a string of characters that appear in the message 
or messages you want to find.

• If distinguishing between upper and lower case 
characters is significant for the search, click once on the
Case Sensitive check box.

• If you want the search to begin with the oldest message 
(the default search order is to begin with the newest 
message), click once on the Search Oldest First check box. 

• Click once on the Search Message Contents/Search Other 
Messages check box.

3. Click once on the Find button.

Result:  The first message containing the string of 
characters opens.
If there is no match, the computer beeps.

4. If you want to find the next occurrence of the text, choose 
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Find Next... from the Edit menu.
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Result: The next message containing the string of 
characters opens.

5. Repeat step 4 until you have found what you needed or 
until the computer beeps, indicating that the all of the 
messages in the mailbox has been searched.

Refiling messages
You can move messages you’ve stored from one box to 
another.  To do this, the box listing window from which you 
want to move the messages must be open.  For instructions 
on how to do this, see “Opening boxes” in this chapter.

-
1. Select the message or messages you want to refile and 

click once on the Refile button.

Result: A dialog box appears 

2. Refile the messages in the desired box.

Result:   The message(s) you’ve refiled has an “X” next to it
indicating that the message has been refiled in the 
specified box and it is marked for deletion.

Saving a message as a
text file

TechMail allows you to save either an incoming message or 
a new message as a text file.  You can then use the file in 
your word processing program.  To save a message as text 
you must have the message open.

-
1. Choose Save Text from the File menu.

Result: A dialog box appears prompting you for a file name.

2. Use the standard Macintosh procedure for selecting a 
folder, type the name, then click on the Save button.

Result: The message is saved in the form of a text file in 
the folder you selected.  The text file icon looks like this
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Including text from
another message

TechMail supports the standard Cut, Copy, and Paste 
features of the Mac.  You can use them to include text from 
another mail message into a mail message you are creating.

-
1. Open the mail message from which you want to take the 

text.

2. Click and drag over the selected text.

3. Choose Cut or Copy from the Edit menu.

4. Open the mail message into which you want to paste the 
text. For instructions on how to do this, see “Opening 
Boxes” in this chapter.

5. Click once where you want the text inserted.

6. Choose Paste from the Edit menu.

Result:  The text is pasted into the mail message.
If there are tabs in the text you pasted into your message, 
the tabs are retained and displayed as arrows.

Including a text file with a
new message

You can include text files with your message by using  the 
Insert file command.  When using this command, the file 
must be a text-only (i.e., no special characters such as 
formatting characters can be in the file).  If you want to 
include a graphics file, word processing file, or a program, 
use the Enclose Binhex command (for instructions on how to
do this see “Including binary files with a new message.”

-
1. Click once in the text of the mail message where you want

the file included.

2. Choose Insert File from the Local menu.

Result:  A dialog box appears allowing you to choose the 
file you want to insert.  Files that cannot be inserted will 
appear gray.

3. Locate the file you want to insert and click once on it.
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Result:  The text of the file appears where the cursor is 
positioned.

If there are tabs in the text file, the tabs are retained and 
displayed as arrows.
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Including binary files with
a new message

Besides including a text file with a message you send, you 
can also include a program, graphics file, or word 
processing document by using the Enclose Binhex command.
Note:  With TechMail 2 version 2 you can include only one file
with a mail message.  If you want to send multiple files to a 
recipient, use an archive program such as Stuffit and create 
a single file, or send multiple messages, one for each file.

Sending binary files
To send a Binhex file, create a new message in the usual 
manner, then

-
1. Choose Enclose Binhex from the Local menu.

Result: A dialog box appears allowing you to choose a file.

2. Select the file you want to enclose and click once on the 
Open button.

Result: The dialog box closes and the message “Enclosure” 
appears at the bottom of the new message.

3. Send the message in the usual manner.

Result: The message is sent with the file attached to it.  
If the recipient is using TechMail 2.0, he or she will see 
the message “Enclosure” indicating that a Binhex file is 
enclosed.   
If the recipient is using TechMail version 1, he or she will 
see the message “Binhex enclosure follows.  Use Binhex 
4.0 to convert.”  The recipient must save the message in a
file, edit out the text part of the message using a word 
processor, then use Binhex to convert the file back into 
it’s original format.
Note: The sending process may take longer than usual 
because Binhex files are often large.   Also, an enclosure 
is not actually attached to a message until it is sent.  If 
you plan to throw out a file that you are enclosing in an 
outgoing message, you should enclose a file, send the 
message, then put the file in the trash.  If you try to put 
the enclosed file in the trash before sending the message, 
this will produce unpredictable results.
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Extracting binary files
from an incoming

message
If someone sends you a message with a binary file, e.g., 
graphic, program, or word processing file enclosed, it is 
indicated with a plus sign (+) next to the envelope icon in 
the box listing window.   You can extract the binary file from 
within TechMail.  To do this, open the incoming message, 
then

-
1. Click on “Enclosure” in the bottom left corner of the 

message.

Result: A dialog box appears allowing you to specify a 
folder and name for the extracted file.

2. Fill in the dialog box:

• Select a folder and enter a name for the file.

• If you want to keep a copy of the binary file with the 
message, click on the “Keep Enclosure” checkbox.

3. Click on the save button.

Result: The Binhex enclosure is extracted from the mail 
message and stored as a file.  

Sending messages in
batches

If you want to send several mail messages at one time rather
than creating and then sending each one separately, you can
create each one, hold each in your outbox, then send the 
entire batch.  It is not only easier for you, it is also a more 
efficient way of transmitting mail on MITnet.  To send mail 
in batches,

-
1. After you create a message, click once on the Outbox 

button.

Result:  The window closes and the mail message is filed in
the outbox.

2. When you complete all your mail messages, choose Send 
outbox from the Server menu.

Result: A message appears confirming that your messages 
are being sent.
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Note:   If you file a message in the outbox and then want to 
change it, open the outbox and refile the message into the
Draftbox.  Make your changes, and repeat steps 1 and 2.  
Do not make changes to mail messages in the outbox.
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Sending messages and
receiving mail

Along with sending message in batches, you can check for 
mail at the same time.  To do this, 

-
Hold down <OPTION> and choose the Send Outbox/Get Mail
from the Server menu.

Result:  A message appears confirming that your messages 
are being sent.  The Get Mail command is executed and 
the inbox window appears with the listing of new 
messages you retrieved along with any other messages 
still in your inbox.

Creating your own
personal address book

You can store names and e-mail addresses in an e-mail 
address book.  When you are creating a mail message you 
can retrieve names and addresses from this address book 
and include them in the “To:,” “Cc:,” or “Bcc:” fields, thus 
eliminating the need to type them each time.  There are 
three functions you can use to maintain and use your 
address book:

• Add and remove entries to the book
• Select entries from the address book and insert them 

into a message you are creating
• Expand recipient names in a mail message you are 

creating to include their e-mail address

Adding and removing entries
Each entry in your address book includes an alias name for 
the person or group for which you want to store an e-mail 
address and the e-mail address itself.  You can modify or 
remove entries.

Adding entries

You can add individual entries or create a mailing list by 
grouping many entries under one alias.

-
Choose Edit Addresses from the Address menu.

Result: The Addresses window appears.
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To add an individual entry,

-
1. Click once at the beginning of the Alias field to place the 

cursor, then type the person’s name or nickname in the 
Alias field.  It can be any form of his or her name, for 
example

John_Doe
John
J_Doe

Spaces are not allowed in the Alias field, but you can use 
an underscore to indicate a space.  You can‘t use upper 
and lower case letters because aliases are not case 
sensitive.

2. Press <TAB>, then type the person’s e-mail address in the 
Address field.

3. To add another entry, press <RETURN> and repeat steps 2 
and 3.

To create a mailing list,
-

1. Type a group name in the Alias field.  It can be one word, 
or more than one word separated by an underscore, for 
example

faculty
sponsored_research

Spaces are not allowed in the Alias field.

2. Press <TAB>.  Then type the first e-mail address in the 
Address field followed by a comma.

Result: The cursor automatically moves to the next line in 
the address field.
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3. Type each e-mail address, followed by a comma,  until you’ve 
entered every e-mail address on the mailing list.

The maximum number of e-mail addresses allowed under 
one alias is 33.

To remove entries from the address book,
-

1. Choose Edit Addresses from the Address menu.

2. Click and drag the cursor over the entry(s) you want to 
delete.

3. Choose Cut from the Edit menu.

Result:  The entry(s) you selected is removed from the 
address book.

4. To close the Addresses window, click once on the Close 
box.

Result: Your address book is up-to-date with e-mail 
addresses you will use in the mail messages you create.
TechMail does not allow you to remove all of the entries 
from an address book, i.e., you must keep at least one 
entry.

Selecting entries for a
message you are creating

To select entries from the address book and insert them into 
a message you are creating,

-
1. In the New Message window, position the cursor where 

you want to insert the addresses.

2. Choose Select Addresses from the Address menu.

Result:  The Addresses window appears.

3. To select one address, click once on the entry, then click 
once on the Select button or double click on the entry.

To select several addresses grouped together, hold down the 
<SHIFT>, key and click once on the first and last address of 
the group you want to select.  Then click once on the Select
button.
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To select several addresses not grouped together, hold down the 
⌘ key and click once on each address you want to select.  
Then click once on the Select button.

Result:  The name(s) and address(es) are inserted in the 
field where the cursor is positioned in the New Message 
window.
If you do not have a New Message window open when you
use Select Addresses, your selection is stored in the 
Macintosh clipboard.  At a later time during your 
TechMail session, you can then use Paste from the Edit 
menu to add the selection into a new message.

Note:  If you select multiple aliases and they do not all appear
in the mail message, see Chapter 7, “Troubleshooting 
Procedures” under the section, “Select Addresses or Expand
options aren’t working” for help.

Expanding recipient names to
include their address

If you type an alias, as it appears in your address book, in 
any of the fields in the header or in the text of a message 
you are creating, you can automatically retrieve his or her e-
mail address by using the Expand function.  You can use this
procedure to “expand” more than one name.

From the New Message window,

-
1. To expand names in the header, type the alias, as it appears in 

the Alias field of the address book, in the “To:,” “Cc:,” or 
“Bcc:” fields of the message you are creating.

To expand names in the text of the message, type the alias, as it 
appears in the Alias field of the address book, in the text 
of the message, then click and drag over the name to 
highlight it.

2. Click once on the Expand button.

Result:  The alias(s) you’ve entered are replaced with the 
e-mail address(es) as they appear in your address book.
To set TechMail so that any new message in the header 
that contains aliases is automatically expanded, see 
“Automatically addressing new messages” in Appendix A 
of this guide.
Note: If you select multiple aliases and they do not all 
appear in the mail message, see Chapter 7, 
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“Troubleshooting Procedures” under the section, “Select 
Addresses or Expand options aren’t working” for help.
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Using and creating public
mailing lists

Computer networks will often provide a service to their 
users by producing and maintaining public mailing lists.  
This service allows users to access a list of names and e-mail
addresses for distributing mail.  A mailing list is usually set 
up for a specific purpose, for example, a special interest 
group.  Using public mailing lists provides many benefits 
over using and maintaining private mailing lists.  Some 
benefits of public lists are:

• If a number of people in your office use the same list, 
only one person needs to maintain it.

• Use of and membership in the list can be supervised, 
thereby eliminating casual or malicious use.

• Members of the list can choose to join or drop out.
• The availability of the list can be easily publicized.

As a user of TechMail, you have access to a public mailing 
list manager called Listserv.  Listserv is provided through 
BITNET, a network of universities and research sites in the 
United States, Canada, Europe, the Middle East, and Japan. 
For instructions on using Listserv, refer to Listserv Quick Start 
(QG-17), available in the MIT Computer Connection, W20-
021.
You also have the option of creating your own public mailing
list.  Since you have a TechMail account, you have access to 
a service provided on MITnet that allows you to create your 
own public mailing list.  For instructions on how to do this 
refer to Creating and Maintaining Mailing  Lists on MITnet (for registered
MIT.EDU and Athena users (NS-9).

Electronically looking up
names and addresses

There are two ways to locate someone’s e-mail address:

• If you want to find an e-mail address within MIT, 
use the Server menu option Directory.
• If you want to find an e-mail address outside MIT, use the 

Server menu option Finger.

The Directory option
The Directory option accesses an on-line version of the MIT 
directory of staff and students.  It includes MIT white page 
information and student directory information.  As with the 
printed directory, it is used only for Institute purposes.  To 
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use the Directory option,
-

1. Choose Directory from the Server menu.
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Result:  You are prompted to enter a person’s name.

2. Enter specific information using one of the following name
formats

last name

first name_last name

first name_middle initial_last name

For example,
John_Doe

3. Then click once on the Ask button.

Result:  If an entry matches the name you requested, it is 
displayed on the screen along with the person’s e-mail 
address and other information.
If there is no match for the name you requested, a 
message to that effect will be displayed on the screen.
If more than one entry matches the name you requested, 
all matches appear on the screen.  To select one, enter the
alias name of the person you want (replacing your original
entry), then click on the Ask button.
You can use the Macintosh Cut, Copy, and Paste features 
to include information, such as the e-mail address, from 
this screen in a mail message you are creating or in your 
address book.

The Finger option
The Finger option accesses directories, similar to the MIT 
on-line directory, at other computer sites on and off campus.
Note: This option is a facility that is implemented differently 
by each participating computer site nationwide.  Bear in 
mind that the information you receive as a result of your 
query may be limited.  Or, you may receive no information.

-
1. Choose Finger from the Server menu.

Result:  You are prompted to enter a username and the 
host computer, i.e., the computer on which his or her e-
mail address resides.

2. Enter the person’s username and host computer, up to 
100 characters maximum.  For example,

Doe@umd.edu
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3. Then click once on the Ask button.

Result:  Information appears in the Finger screen if there 
are entries that match the name on the host you specified 
and if that host supports Finger.  If Finger is not 
supported by the host computer you specified, no 
information appears on the screen or a message appears 
stating that the connection was refused.
You can use the Macintosh Cut, Copy, and Paste function 
to include information, such as the e-mail address, from 
this screen in a mail message you are creating or in your 
address book.

For further information about the Finger option, refer to 
MITnet On-Line Directory Quick Guide (QG-18) available in the MIT
Computer Connection, W20-021.
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Chapter 6 Tips and Techniques for 
Using TechMail

Chapter objectives
This chapter suggests ways to maximize the use of TechMail 
and e-mail in general.  The topics covered are:

• Ways to use TechMail effectively 
• Tips for using TechMail
• E-mail ethics and conventions
• E-mail customs

Ways to use TechMail
effectively

If you find you are relying heavily on TechMail for 
corresponding with colleagues and friends, here are some 
ways you can use it more efficiently and effectively:

• Send outgoing mail in batches.  By doing this, you eliminate 
having to wait each time TechMail connects to MITnet 
and transmits a single message.  Sending many 
messages at once takes the same amount of time as 
sending one message.  (See “Sending messages in 
batches” in Chapter 5 of this guide.)

• Save and organize mail messages in boxes by subject.  If you find 
that you want to refer at a later time to incoming e-mail, 
create boxes in which to file the messages so that they 
are easy to find and retrieve.  You can then re-read them
and also use portions of them in mail messages you are 
creating.  
For instructions on how to organize mail messages into 
boxes, see “Saving mail messages” in Chapter 3 of this 
guide.  For instructions on including portions of an 
incoming mail message in a message you are creating, 
see “Including text from another message” in Chapter 5 
of this guide.

• Create mailing lists for groups of people to whom you frequently 
send mail.  This will eliminate your typing an address 
incorrectly, thereby getting the mail message returned 
to you.  (See “Creating your own personal address book”
in Chapter 5 of this guide.)
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• Keep your inbox as neat as possible.  As you retrieve mail, take
action on it, even if that means refiling it to another box 
until you have time to respond.  This way, your inbox will
not be cluttered with a lot of mail.  The more messages 
you have in it, the more difficult it becomes to 
distinguish new from old; also, the processing time for 
receiving mail takes longer.

• Use public mailing lists when possible.  Public mailing lists 
offer a lot of benefits.  They are already set up for you 
and someone maintains them, so they are likely to be 
current.

Tips for using TechMail
The following is a list of tips that will make it easier to use 
TechMail.

How to move messages to
another Mac

Some people use TechMail on more than one Mac, e.g., their
Mac at work and their Mac at home.  If you need to move a 
large number of e-mail messages from one Mac to another, 
here is an easy way to do it:

-
1. Put a formatted diskette with adequate free space into the

diskette drive.  

2. Open TechMail, then open the box from which you want to
move the messages

3. Select all of the messages you want to move.  (For 
instructions on how to select multiple message, see “How 
to select messages” in Chapter 2 of this guide.)

4. Click once on the Refile button.

5. Click on the drive button in the refile dialog box until the 
diskette drive is selected.

6.  Click once on the new button.  When the new mailbox 
dialog box appears, enter a mailbox name, then click on 
the Save button.

Result: A new mailbox is created on the diskette and the 
selected message are moved into it.
Take the diskette to your other Mac and use the Open Box
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command to see the message on your diskette.
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Note:  By using refile, the selected messages have been 
moved from the mailbox on your Mac to the new mail box 
on your diskette, i.e., there are no longer copies of these  
messages in the original mailbox.  If you need to retrieve 
the original messages and the box listing window is still 
open, highlight the messages, then choose retrieve from 
the Local menu.

An easy way to temporarily
store messages

If you find that you receive messages that you want to keep 
for a short period of time, then delete, rather than leaving 
them in your inbox and cluttering it up, try this technique:

-
1. Create a new mailbox called something like “(temp).”  If 

you enclose it in parentheses, this mailbox will appear at 
the top of the list anytime you refile a message.  

2. Whenever you receive a message that you want to store 
temporarily, select it, click on the refile button, then press 
return.

Result: The message is refiled in the first mailbox in the 
list, i.e., (temp).

3. On a periodic basis, maybe once a month, open (temp) 
and go through it, deleting any messages you don’t want.  

If you know that you want to delete messages older than a
certain date, use this technique:  go to the top of the list 
and click once on the first message, scroll down to the last
message of the group, hold down the shift key and click 
on the last message, then click on the delete button.
If you know that you want to delete all of the messages in 
the box, just move the box to the trash.  You can start the 
process again by recreating the mailbox called (temp).

E-mail ethics and
conventions

The arrival of e-mail as a medium of communication has 
prompted a number of questions and issues about ethics, 
conventions, and customs.  For information on e-mail ethics 
and conventions, read Toward an Ethics and Etiquette for Electronic 
Mail (R-3283-NSF/RC), by Norman Z. Shapiro and Robert H. 
Anderson.  It is available at a cost from The RAND 
Corporation, P.O. Box 2138, Santa Monica, CA  90406-2138. 
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E-mail customs
Some labels have evolved into common usage in sending e-
mail.  They are a result of e-mail writers’ attempts at 
clarifying their messages.

:-) Indicates humor.
:-( Indicates unhappiness
*visual cue*Visual cues can be written into the 

message and enclosed in asterisks.
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Chapter 7 Troubleshooting Procedures

Chapter objectives
This chapter covers the kinds of problems you may 
encounter when you use TechMail and how to solve them.  
The sections in this chapter describe:

• Problems and solutions
• Error messages and corrections

Problems and solutions
The following is a list of problems that may occur when you 
are using TechMail and troubleshooting procedures that 
lead you to a solution.
Bear in mind that some problems you encounter may be 
caused by conditions external to the TechMail program 
running on your Mac.  For example, MITnet or one of the 
servers  (a computer that stores or directs data) on MITnet 
may have a problem, or a power outage can occur.  If you 
encounter a problem when using TechMail that is external to
your installation, call the Network Help Desk, x3-4101, and 
report it.   If the Help Desk is already aware of the problem, 
they may be able to update you on it’s status.

Can’t Check Mail or Get Mail
When you choose either Check Mail or Get Mail, TechMail 
has to access the post office server.  Several steps are 
involved in each of these options which, when they occur 
successfully, are invisible to the user.  If a problem occurs, it 
can be at one of these steps:

• Get an IP address (a numerical address that identifies 
your computer on MITnet) for your Macintosh.

• Check the nameserver for the host address.
• Check your username on the post office server.
• Check your password on the post office server.

The following list describes possible reasons why the Check 
Mail or Get Mail menu options are not working.  Go 
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through the list in order and follow the instructions to 
determine where the problem is:

1. You entered your password incorrectly.

The error message “Incorrect password” appears on your 
screen.  Choose the Check Mail or Get Mail menu option 
again and re-enter your password (remember, passwords are
case sensitive).

2. The network connection behind your workstation is unplugged.

Check the connections in the back of your Macintosh.  Make
sure they are all plugged in.

3. The gateway is malfunctioning.

If you are connected to an AppleTalk network, a gateway, 
such as the Shiva Fastpath, is the means by which your 
Macintosh connects to the MITnet.  If you have entered your
password correctly, and checked the network connection 
behind your workstation, then talk to your AppleTalk 
network administrator to find out if there is a problem with 
the gateway.

4. There are no IP addresses available.

If you access the MITnet via AppleTalk, you are actually 
sharing access with all of the other users on your AppleTalk 
network.   This is because a limited number of IP addresses 
are assigned to your AppleTalk network.  If many users on 
the AppleTalk network are all accessing IP addresses at the 
same time, some users may be shut out temporarily.  If this 
is the case, just try again later.

5. There is a break in the MITnet.

If certain parts of MITnet are malfunctioning, it can affect 
TechMail’s attempts to complete the process.  If you have 
verified that you are entering your password correctly, and 
there is no problem with your connection to MITnet, call the 
Network Help Desk at x3-4101 and report the problem.

6. There is an Institute or city-wide power failure.
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MITnet will shut down in the event of a widespread power 
failure.  Even after power is restored, it may take some time 
for the entire network to become operational.  If you try to 
use TechMail right after a power failure and are 
unsuccessful, wait awhile and try again.

Finger or Directory search
fails
The following list gives reasons why you may be unable to 
locate an e-mail address with either Directory or Finger:

The person’s name and/or host name is misspelled.

Make sure you’ve spelled the person’s name correctly.  If 
you are using Finger, make sure you’ve spelled the host 
name correctly.

The Directory server or specified host is down.

If you are using the Directory option and the Directory 
server is down or the Finger option and the specified host is 
down, the attempt made by TechMail to access the server or 
host will fail after a couple of minutes.   The failure will 
produce an error message.   If you have eliminated the first 
two reasons in this list, try the task again a while later.

No entry exists for your request.

For many reasons, there may not be an entry matching the 
request you made.  In this case, you may need to call the 
person directly.

Finger may not be supported on the specified host.

Some host machines do not support Finger.  When this is the
case, you either receive no information, or you may get an 
error message such as “Connection Refused.”  In this case, 
you may need to call the person directly to get the 
information you want.

A problem exists with MITnet or your connection to MITnet.

If you have determined that none of the reasons above are 
the cause of the failure, go through the list of reasons in the 
previous section, “Can't Check Mail or Get Mail” to 
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determine if there is a problem with your connection to 
MITnet, or MITnet itself.
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Mail you’ve sent is returned to
you
When you send a message and TechMail cannot successfully 
deliver it,  the message is returned to you.  You receive a 
message that includes the text of your mail message along 
with information about why the mail was not delivered.  
Check spelling and syntax of the “To:” field and make sure 
you’ve spelled the username correctly and that the spelling 
and syntax of the e-mail address is correct.  

Your password is not
accepted

There are several reasons why your password may not be 
accepted:

You typed your password incorrectly.

You may have made made a typographical error when you 
entered your password.  Click on the OK button, reselect the
menu option, and try entering your password again.  If you 
specified a password using mixed case, for example, 
“13FRob2” make sure you enter the upper-case letters in 
upper case and the lower-case letters in lower case.

The caps lock key is depressed.

Passwords are case sensitive.  If you have the caps lock key 
depressed when you type your password, TechMail will not 
recognize your password (unless you specified a password in
all upper case).  Click on the OK button.  Disengage the caps
lock key, reselect the menu option, and try entering your 
password again.

You are not registered to use TechMail.

TechMail will not recognize your password if you have not 
completed the registration procedure for getting a mail box 
on the post office server.  To complete the procedure you 
need to fill out the TechMail Registration Form on the last 
page of the TechMail Getting Started Guide for Macintosh Computers 
and send it to E40-311A.  In about 10 business days, you will
receive confirmation by campus mail that your account is set
up.  At this point, you’ve completed the registration process.
If you’re not sure whether your registration has been 
completed, call the Network Help Desk at x3-4101.
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NCSA Telnet, MacIP, or
TN3270 don’t work

TechMail is not compatible with non-MacTCP versions of 
these programs.  If you are using any of these programs, you
can arrange to get the MacTCP versions by calling the 
Network Help Desk, x3-4101.

Select Addresses or Expand
options aren’t working

If you’ve included multiple addresses in a mail message you 
are creating by using the Select Addresses or Expand 
options, and some of them are not appearing, lengthen the 
window by clicking and dragging the size box in the lower 
right corner. 

“???” appears in the header
of an incoming message

If you open an incoming message and see question marks in 
any of the fields of the header, this means that the mail 
message has been damaged.  If it is an old mail message for 
which you have a backup copy, retrieve the mail message  
from your backup.  If it is an incoming message that you’ve 
just received, there is nothing you can do unless you know 
who the sender is and ask them to re-send the message.  If 
you receive a number of messages like this from the same 
sender, it may be the e-mail system they are using.  If you 
start to receive messages like this regularly from more than 
one e-mail system, there could be a problem with your hard 
disk.  If this is the case, you may want to have your hard disk
checked.

Error messages and what
to do

If you see an error message on your screen, look it up in the 
“List of error messages” in the next section for instructions 
on how to proceed. 
Every circumstance under which these error messages may 
occur has not been identified.  If you experience any of these
error messages under circumstances not described in this 
section, or if you have any other information to add to this 
section, send e-mail to bug-techmail@mit.edu.

List of error messages
The following is a list of error messages and what to do if  
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you receive them.  They are organized alphabetically.  If you 
are unsuccessful at solving the problem, call the Network 
Help Desk at x3-4101.
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A configuration resource is missing
The file called TechMail Settings in your TechMail folder (or 
in your System folder if you are running TechMail from the 
desktop) is bad.  Throw out the TechMail Settings file by 
dragging it to the Trash.  Start up TechMail and reset your 
username.  If you had previously set any other user 
preferences, reset them.  TechMail will generate a new 
TechMail Settings file in the folder called TechMail Folder.  
If you are using TechMail from your desktop, move the 
TechMail Settings file into the System folder.
3* Activating free window

* Asking about invalid attributes

* Attribute not found

* Bad format in mail file

* Bad length on TCP operation

Cannot create file or Can’t open file
Either your hard disk or a diskette from which you are trying
to open a box is full, or you are trying to open a box on a 
locked diskette.  Free up some space on the disk or diskette 
by moving some files onto another disk.  If you’re using a 
diskette, check to make sure it is not locked.  Then try again.

Cannot delete old mail file
Restart your Mac.

Can’t rename <filename> to <filename>
Make note of this error and call the Network Help Desk at 
x3-4101.

3* See the following section “Handling difficult errors”
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Cannot open TechMail Addresses
The file called TechMail Addresses may be missing or you 
are trying to use the Expand option and you have not 
created an address book.  You must create an address book 
before you can use the Expand option.  If you have created 
an address book, open the TechMail folder and see if the file 
called TechMail Addresses is there.  If it is not there, check 
the rest of your hard disk to see if it has been moved.  If you 
can’t find it, you need to either restore the TechMail 
Addresses file from your backup diskette or recreate your 
address book. 

Cannot open mail file
Either your hard disk or a diskette from which you are trying
to open a box is full, or you are trying to open a box on a 
locked diskette.  Free up some space on the disk or diskette 
by moving some files onto another disk.  If you’re using a 
diskette, check to make sure it is not locked.  Then try again.

Cannot open new address file
You are trying to create an address book and your disk is 
full.  Free up some space on your disk by moving some files 
onto another disk, then try again.

Cannot open Techmail Help
The file called TechMail Help may be missing.  Open the 
TechMail folder and see if the file called TechMail Help is 
there.  If it is not,  check the rest of your hard disk to see if 
it has been moved.  If you can’t find it,  get a copy of 
TechMail Help from the TechMail program diskette you 
received when you obtained TechMail, and copy it to your 
hard disk.

Cannot parse address book
The file called TechMail Addresses is bad.  First, try using 
the Edit Addresses option from the Addresses menu and look
at your address book to make sure it is correct, i.e., Aliases 
and Addresses are in the correct columns.  If you can’t find 
the problem using Edit Addresses, you need to either restore
the TechMail Addresses file from your backup diskette or 
recreate your address book.
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Cannot refile to same file
You chose Refile and selected the box in which the message 
was already filed.  Choose Refile again and select a different 
box.
4* Cannot reopen old rmail

Cannot save settings
You have attempted to save new settings and either your 
hard disk is full or the diskette is locked.  Free up some 
space on the disk or diskette by moving some files onto 
another disk.  If you’re using a diskette, check to make sure 
it is not locked.  Then try again.

Cannot send to "<user>"
You have addressed a new message incorrectly.  Check the 
“To:,” “Cc:,” and “Bcc:” fields and make sure each field 
contains the full e-mail address of each recipient, i.e., not 
just the user name.  For example, jdoe is incorrect, but 
jdoe@eagle.mit.edu is correct.

Cannot write file
Either your hard disk or a diskette from which you are trying
to open a box is full, or you are trying to open a box on a 
locked diskette.  Free up some space on the disk or diskette 
by moving some files onto another disk.  If you’re using a 
diskette, check to make sure it is not locked. Then try again.

Cannot write mail file
You are trying to close a box and either the hard disk is full, 
or you are trying to close a box on a locked diskette.  Free 
up some space on the disk or diskette by moving some files 
onto another disk.  If you’re using a diskette, check to make 
sure it is not locked. Then try again.

Cannot write new address book
You are trying to close your address book and either the 
hard disk is full, or you are trying to save your address book 
on a locked diskette.  Free up some space on the disk or 
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diskette by moving some files onto another disk.  If you’re 
using a diskette, check to make sure it is not locked. Then 
try again.

* Can’t expand rmail

* Can’t get volume info

* Can’t open free window

5* Closing closed window

Connection already open
You have two copies of TechMail in different folders  and you
have mistakenly started up TechMail twice.  Click on the  
menu and see if TechMail is listed twice.  If so, select one of 
the copies and exit that copy of TechMail.

Connection closing
A problem has occurred when you were using one of the 
options under the Server menu.  Also, this message can 
occur briefly during normal operation as well.

* Connection not open

Connection refused
A problem has occurred when you were trying to send or 
receive mail, or use the Finger or Directory options.  If you 
are trying to use the Finger option, it can also mean that the
Finger service is not supported on the host machine from 
which you are trying to get information.   If you are trying to
send or receive mail, or use the Directory option, try again 
in a few minutes.  If the problem persists, call the Network 
Help Desk, x3-4101.
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Connection reset by peer
A problem has occurred when you were trying to send or 
receive mail, or use the Finger or Directory options.  Try 
again a few times at 10 minute intervals.
6* Copying bad message

* Copying negative string

* Deactivating free window

* Didn’t fill headers correctly

* Drawing free window

Duplicate connection
You have 2 copies of TechMail in different folders  and you 
have mistakenly started up TechMail twice.  Click on the  
menu and see if TechMail is listed twice.  If so, select one of 
the copies and exit that copy of TechMail.

Error in getting address from server
There may be a problem with the gateway which connects 
the AppleTalk network, to which your Macintosh is 
connected, to MITnet.  Contact the system administrator of 
the AppleTalk network to find out if there is a problem.

Error parsing address book
The file called TechMail Addresses is bad.  First, try using 
the Edit Addresses option from the Addresses menu and look
at your address book to make sure it is correct, i.e., Aliases 
and Addresses are in the correct columns.  If you can’t find 
the problem using Edit Addresses, you need to either restore
the TechMail Addresses file from your backup diskette or 
recreate your address book.
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Error reply from POP server
There is a problem with the post office server.  Call the 
Network Help Desk at x3-4101 and report the problem.

Error reply from SMTP server
An address in the “To:,” “Cc:,” or “Bcc:” fields contains an 
extra parenthesis or there is a problem with the outgoing 
mail server.  First, check all addresses in the header of the 
mail message to make sure they are correct.  If they are 
correct, call the Network Help Desk at x3-4101 and report 
the problem.
7* File is not a mail file

* File too large for sending

From address <text> does not match user
The file called TechMail Settings in your TechMail folder (or 
in your System folder if you are running TechMail from the 
desktop) is bad.  Throw out the TechMail Settings file by 
dragging it to the Trash.  Start up TechMail and reset your 
username.  If you had previously set any other user 
preferences, reset them.

* Getting wrong text

* Getwd failed

* Growing free window

Host is unknown
The post office server, outgoing mail server, or directory 
server settings under the User Preferences option have been
changed or you have specified a non-existent host when 
using the Finger option.  If you are using the Finger option, 
make sure you have spelled the host name correctly.  If you 
are using the Check Mail, Get Mail, or Directory options, go 
into User Preferences and compare the settings in this box 
for post office server, outgoing mail server and directory 
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server with the settings listed in “See more options” in 
Appendix C of this guide to make sure they are correct.  If 
any are different, correct them, then click once on the OK 
button.

Host not in name cache
Your connection to the MITnet may be malfunctioning.  
Check the back of your computer to make sure that no 
cables have been unplugged .  If they are all plugged in and 
you are connected to MITnet via an AppleTalk network, talk 
to your AppleTalk network administrator and find out if 
there is a problem with the gateway.  If you are unable to 
get an answer, call the Network Help Desk at x3-4101.

Hostname syntax error
Either you are using Finger and you specified an incorrect 
host, or the post office server, send mail server, or directory 
server has been changed under the User Preferences option.
If you are using Finger,  check your typing and make sure it 
is correct.  If you are using the Check Mail, Get Mail, or 
Directory options, go into User Preferences and compare the
settings in this box for post office server, outgoing mail 
server and directory server with the settings listed in “See 
more options” in Appendix A of this guide to make sure they 
are correct.  If any are different, correct them, then click 
once on the OK button.
8* Inconsistent copying

* Inconsistent number of messages

Incorrect password
You’ve entered your password incorrectly when you were 
trying to send or receive mail.  Try sending or receiving 
again and re-entering your password.  Make sure the caps 
lock key is not depressed—passwords are case sensitive.  If 
you still get the same message, this means your original 
password is not recognized by Kerberos.  Try one of the 
following:
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• If you were contacted by the Postmaster and chose a 
new password that is acceptable by Kerberos, use the 
new password.

• If you have an Athena account with a password that is 
different from your TechMail password, use your Athena 
password.

• If you don’t know your Kerberos password, call x3-1325 
to find out how to reset it.

Insufficient space for new messages
You’ve run out of disk space.  Take some files from your hard
disk and put them onto a diskette, then try Get Mail again.
9* Invalid buffer

* Invalid POP state

* Invalid message number

* Invalid RDS

* Invalid window

* Invalid window type

Maildrop for username is busy
When you are trying to receive mail, the post office server is 
simultaneously receiving mail for you from another source.  
Click on the cancel button, then try receiving again in a few 
minutes.  If you continue to receive this error message, send
e-mail to postmaster@mit.edu describing the problem and 
giving your phone number so you can be notified when the 
problem is fixed.

* Message is too large
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10* Mousing free window

Name server returns an error
Try the task again.  If the problem persists, restart your Mac
and call the Network Help Desk at x3-4101. 

No addresses in To: field
You have not entered a username and address in the “To:” 
field of a new message.  Enter the recipient’s name and 
e-mail address, then send the message.

No from field in message
Try exiting and restarting TechMail.  If the problem still 
exists, call the Network Help Desk at x3-4101.  

No name server found
The MacTCP configuration information may have been 
corrupted.  Open your System folder and drag MacTCP to 
the Trash.  Reinstall MacTCP from your TechMail program 
diskette, then restart your Mac.  If you are connected to 
MITnet with an Ethernet card, follow the instructions in 
Appendix C of this guide to set MacTCP to run on your Mac. 
Then restart your Mac.

No name servers responding
A problem has occurred when you were trying to send or 
receive mail, or use the Finger or Directory options.  Make 
sure that your connection to either MITnet or the AppleTalk 
network in the back of your Macintosh is plugged in.  Then, 
try again a few times at 10 minute intervals.

No new mail
There are no mail messages waiting for you on the post 
office server.
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No password given
Try exiting and restarting TechMail.  If the problem still 
exists, call the Network Help Desk at x3-4101.  

No recipients specified
You tried to send a new message without specifying any 
recipients in the header.  Check the message to make sure 
that you’ve entered all usernames and e-mail addresses 
correctly in the “To:,” “Bcc:,” and “Fcc:” fields, then try 
sending it again. 
11* No result procedure

* Not enough room in application heap

Operation timed out
A problem has occurred when you were trying to send or 
receive mail, or use the Finger or Directory options.  Try a 
few times at 10 minute intervals. 

Out of domain name memory
Exit TechMail, then restart your Mac.  If the problem 
persists, call the Network Help Desk at x3-4101.

Out of memory
TechMail can’t perform the task because there isn’t enough 
memory.  Make a note of what other programs, e.g., Excel, 
you are running, if any,  and what task you were trying to do 
in TechMail (e.g., refile a message).  Exit all other programs 
you may be running, then go back to TechMail and try the 
task again.  If the problem persists, exit TechMail and 
restart your Macintosh.  If this solves the problem, please 
send a message to bug-techmail@mit.edu describing the 
error and the circumstances.  If the problem still persists, 
call the Network Help Desk at x3--4101.

POP server not set
The post office server setting under User Preferences has 
been changed.  Choose User Preferences.  Go into User 
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Preferences and make sure “eagle.mit.edu” is the setting for
post office server.  If it is different, correct it, then click once
on the OK button.

Principal unknown

This means that your username is not recognized by 
Kerberos.  Make sure your username is entered in all lower 
case in User Preferences.  (Remember that usernames are 
case sensitive.)  If you still get this message, call x3-4101, 
report the problem, and give them your username.  
12* Selecting free window

* Setvol failed

SMTP server not set
The outgoing mail server setting under User Preferences 
has been changed.  Go into User Preferences and make sure 
“mit.edu” is the setting for outgoing mail server.  If it is 
different, correct it, then click once on the OK button.

* Stream already open

* Stream not open

The manually set address is configured improperly
You are connected to the MITnet with an Ethernet card and 
MacTCP has not been set correctly for use on your Mac.  
Complete the instructions in Appendix C of this guide if 
you’ve not already done so.  If you already completed 
Appendix C, go over the instructions again to make sure you 
completed them correctly.

The Username field is not your email address; it should not contain the 
@ character.  Please fix up the Username field and try again.
You have entered both your username and e-mail address in 
the Username field of the User Preferences dialog box.  
Delete everything after the @sign, leaving just your 
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username.  For example, if jdoe@mit.edu was entered in the 
Username field, jdoe would delete “@mit.edu” and leave 
“jdoe” in the Username field.

Too many connections open
You have two copies of TechMail in different folders  and you
have mistakenly started up TechMail twice.  Click on the  
menu and see if TechMail is listed twice.  If so, select one of 
the copies and exit that copy of TechMail.

Too many mail files open
You have too many boxes open at the same time.  Close 
some boxes before trying to open another one.

Too many windows
You have too many windows open at the same time.  Close 
some windows before trying to open another one.

Unable to initialize the local network handler
Restart your Mac.

Unable to write file
You are trying to close a box and either the hard disk is full, 
or you are trying to close a box that has changed on a locked
diskette.  Free up some space on the disk or diskette by 
moving some files onto another disk.  If you’re using a 
diskette, check to make sure it is not locked. Then try again.

Unknown user
Your username, as it is entered in User Preferences, is 
incorrect.  Either you’ve entered your name wrong, or you 
have not completed the registration process for TechMail.  If
you have not registered to use TechMail, complete Section 2
of the TechMail Getting Started Guide for Macintosh Computers.  If 
you’ve received confirmation that your registration has been
processed, choose User Preferences from the File menu and 
check your username to make sure it is entered correctly. 

User aborted operation
You have typed ⌘-period (.) to abort a command.
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User not set
Try exiting Techmail and starting up again.  If the problem 
persists, restart your Mac and call the Network Help Desk at
x3-4101. 
13* Writing invalid message

You cannot save text to an open mailbox
Try exiting Techmail and starting up again.  If the problem 
persists, restart your Mac and call the Network Help Desk at
x3-4101. 

Handling difficult errors
If an error message has caused your Macintosh to “shut 
down” (crash), try restarting your Mac, then starting up 
TechMail.  If the problem doesn’t re-occur, just send e-mail 
to bug-techmail@mit.edu and report the error.
If the error re-occurs, gather as much information as 
possible about the circumstances under which the problem 
occurred, including:

• Is this the first time you’ve used TechMail or have you 
been using it for a while?

• Are you also running cdevs (third party programs that 
run automatically when you start your Mac)?

• Were you using any desk accessories?
• Have you installed a new program on your Mac since the

last time you used TechMail?  Is the program a cdev or 
desk accessory (resources you access under the  
menu)?

• Have you changed any of the TechMail User Preferences
or moved any of the TechMail files around on the disk?

• Does more than one person use your Macintosh?
• Is your Macintosh directly connected to an Ethernet 

outlet (Ethernet drop)?
Then call the Network Help Desk at x3-4101.
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Appendix A Setting User Preferences

User Preferences
The User Preferences feature in TechMail allows you to 
change some of the functions of TechMail to suit your 
working style.  
TechMail retains your changes by saving them in a file called
TechMail Settings.  Your changes are activated each time 
you start up TechMail and remain in effect until you change 
them again.

Setting User Preferences
To set User Preferences,

-
Choose User Preferences... from the File menu.

Result:   A dialog box appears with the functions you can 
set.

On Startup options
On Startup options are functions that will be performed each
time you start TechMail.  To activate any of the On Startup 
options, 

-
Click once on the radio button next to the option you want
to set.
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The following table lists the On Startup options and their 
purpose.

Option Purpose

Get Mail Gets your mail from the post office server 
and transfers it to the inbox on your 
Macintosh.

Check for Mail Checks your mailbox on the post office
server and informs you of how many 
incoming mail messages you have.

Compose a Opens the New Message window and 
New Messagedisplays a blank message form.

Do nothing TechMail starts without performing a
startup task or displaying the startup 
screen.

Show Spiffy Displays the TechMail envelope and 
Startup Screen stamp. (This is the default setting.)

Saving outgoing messages
To automatically save a copy of each of your outgoing 
messages,

-
Click once on the File Copy to check box.  Then type either 
the name of the box in which you want messages saved, or
if you want to specify a box name at the time you created 
the message, leave it blank (the default is no file copy).

Note:  Do not specify “inbox,” “outbox,” or “Draftbox” for 
filing copies.  These boxes are already used by TechMail 
for other purposes.  Also, when you click on Send, the 
FCC copy is saved before the message is sent.  Therefore, 
the existence of the FCC copy in the specified box is not 
an indication that the message was successfully sent.
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Automatically addressing new
messages

You can set TechMail so that the expand function is 
automatically performed each time you create and send a 
new message.   The expand function uses your address book 
to replace names you’ve typed in the header of your new 
message with e-mail addresses as they appear in your 
address book.  It replaces only names that match aliases 
you’ve entered in your address book.

-
Click once on the Auto-expand Aliases on Send check box, (the
default is no auto-expand).

Customize the header
You can add a custom header field that can be edited before 
sending, or a static header field that is added to your 
message upon sending.  A static header field is useful if you 
want to receive mail at a different e-mail address than your 
TechMail address.  Or, use it to include additional personal 
information such as your mailing address and phone 
number.  To add another field to the header of the messages 
you create,

-
1. Click once on the Custom Header Field button.

Result: The custom header field screen appears:

2. Enter header fields in the appropriate box:

• If you want a custom header field that you can edit 
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before sending, enter it in the “One Header Field that 
can be edited when sent:” box.  
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• If you want one or more static header fields, i.e., 
headers that you can’t change, enter them in the 
“Static Header Field” box.  
Note: Use this option if you want to Bcc: yourself on all 
outgoing messages and have them sent to an e-mail 
address other than the one that is used when you select
the Bcc: Myself on all outgoing messages option on the 
second screen of User Preferences.

3. Click on OK.

Result: Header fields that can be edited will appear in the 
header of a New Message.  Static header fields will 
appear when the recipient retrieves your mail message.

See second screen of options
To see a second screen of options,

-
Click once on the More... button.

Result:  A dialog box appears with more options.

Note:  Do not change the Outgoing Mail Server (mit.edu) 
and Directory Server (mit.edu).   Also, leave the Use 
Hesiod to find POP Server check box activated unless 
you’ve determined that you can’t use Hesiod (for more 
information on turning off Hesiod, see the next section).  
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Turn off Hesiod
TechMail, by default uses Hesiod.  Hesiod is a function, 
invisible to you, that finds your mailbox on MITnet.  This 
means that the post office server box may be left blank if 
Hesiod is used.  Hesiod will allow TechMail to find any user’s
mailbox, i.e., it is no longer necessary (as in TechMail 
version 1) to specify the name of the server on which your 
mailbox resides, e.g., eagle.mit.edu.
If you have determined that you should not use Hesiod, 

-
1. Click once on the Use Hesiod to find POP Server check box.

Result:  Hesiod is no longer active.

2. Type the name of the post office server where the mailbox
is located that you want to retrieve mail in the Post Office 
Server box, e.g., eagle.mit.edu.

Result:  When you use either Check Mail or Get Mail, 
TechMail will access your mailbox on the specified server.

Enlarge display text
To enlarge the size of text displayed on the screen,

-
Click on the 12 pt radio button (the default is 9 point).

Result: The contents of TechMail windows are displayed in 
12 point text.  This takes place the next time you open a 
window.

Display entire header
To display the entire header information on all incoming 
mail messages (this can include more detailed information 
on who sent the message and the route taken),

-
Click once on the Show Long Headers check box (the default 
is not to show long headers).

Result: All incoming messages are displayed with the 
entire header information.  This takes effect the next time 
you open an incoming message.

Carbon copy to yourself

*See “Handling Difficult Errors” following this section



To have a blind carbon copy of all outgoing messages mailed
to you,
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-
Click once in the Bcc Myself on all Outgoing Messages check 
box (the default is not to send blind carbon copies).

Result: Each time you create and send a message, a blind 
carbon copy is sent to you.
Note:  If you use this feature, blind carbon copies will be 
addressed to username@mit.edu, the outgoing mail server.  
If you prefer to have blind carbon copies addressed to you
at another address, e.g., username@athena.mit.edu, use the
Custom Header option.  For instructions on how to do 
this, see “Customize the Header” in this Appendix.

Change folder where boxes
are stored

To change the folder in which your TechMail boxes are 
stored,

-
1. Click once on the Change File Folder button.

Result:  A dialog box appears allowing you to select a 
different folder.

2. Select a folder, then click on the Set button.

See third screen of options
To see the third screen of options,

-
Click once on the More... button.

Result:  A dialog box appears with more options:
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Choose icon sets
You can choose from two kinds of icons sets to be used for 
indicating read and unread messages in a box listing 
window.  To do this,

-
Click once on either the desired icon or it’s associated 
radio button.

Result:  If you chose the envelope icon, closed envelopes 
appear next to unread messages, and open envelopes 
appear next to read messages.
If you chose the bullet icon, the bullet appears next to 
unread messages and nothing appears next to read 
messages.

Change width of send window
Do not change this number from 72 unless you’ve 
determined that all or most of your mail recipients can read 
your messages on a larger screen.

Change box listing window
The default setting for the box listing window is to show the 
From: field for all received messages.  You can change this 
to show both the From: field and the To: field.  To do this,

-
Click on the From/To radio button.

Result: All box listing windows will display both the From: 
field and the To: field. 

To change back to just the From: field, click on the From 
radio button.

Turn off Kerberos
authentication

TechMail, by default, uses Kerberos authentication.  
Kerberos gives TechMail the ability to send passwords 
encrypted over MITnet.  We recommend that you use 
Kerberos to improve security when using TechMail.  
However, if you choose not to use Kerberos, you can turn it 
off.  To do this,

-
Click once on the Use Kerberos Authentication checkbox.  
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Result:  Your messages flow unencrypted (in clear text) 
across the network.  

*See “Handling Difficult Errors” following this section



Exit User Preferences
To exit User Preferences,

-
Click once on the OK button in each User Preferences box.

Result:   The changes you made are saved in a file called 
TechMail Settings and are activated each time you start 
up TechMail.   They remain in effect until you change 
them again.

Note:  Some settings require that you exit TechMail and start 
up again for them to take effect.
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Appendix B TechMail Menu Selections

The following tables give each menu option and its function.  When a keyboard 
equivalency has been assigned, it is indicated next to the menu option.

File Menu Selection Key Equiv. Function

Open Box -O⌘ Allows you to select a box to open.  A 
listing of the contents of the box appears
on the screen.

Open Message <enter> Opens a a selected message in a 
box listing window.

Close -W⌘ Closes the active window.

-<option>-W⌘ Closes all windows.

Save Draft -S⌘ Saves a draft of a message you are 
creating in the Draftbox.

Save text none Saves a copy of an incoming message as 
a text file.

Page setup none Allows you to specify certain settings for
printing.

Print... -P⌘ Prints the active window, selected 
messages, or box listing.

Help none Displays a Help file on the screen.

User Preferences none Allows you to change certain functions 
of TechMail.

Hide Deleted Msgs none Removes display of deleted messages 
from a box listing.

Quit -Q⌘ Exits TechMail.

*See “Handling Difficult Errors” following this section



Edit Menu Selection Key Equiv. Function

Undo -Z⌘ Undo the previous action if that action 
was a cut, paste, or delete of highlighted
text.  (Does not undo a paste in the Edit 
Addresses window.)

Cut -X⌘ Removes selected text from a mail 
message or address book and stores it in
the clipboard.

Copy -C⌘ Copies selected text from a mail 
message or address book and stores it in
the clipboard.

Paste -V⌘ Inserts text from the clipboard in front 
of where the cursor is positioned in the 
active message.

Clear <delete>
or
<backspace>

Removes selected text from a mail 
message or address book.

Find -F⌘ Searches for an occurrence of a 
specified string of characters in a mail 
message or messages, box listing, or 
Help file.

Find Next -G⌘ Searches for the next occurrence of a 
specified string of characters in a mail 
message, box, address, or Help file.

Select All -A⌘ Selects all messages in a box, or selects 
all addresses in an address book.
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Local Menu Selection Key Equiv. Function

New Message -N⌘ Opens a window with a blank mail 
message.

Reply -R⌘ Creates a blank mail message addressed
to the sender of the incoming mail 
message you were just reading, i.e., the 
active window.

Reply with Text -<shift>-R⌘ Creates a message with the header 
information and text of the message of 
the incoming mail message you were 
just reading i.e., the active window.

Reply All -<option>-R⌘ Creates a blank reply to all recipients of 
an incoming message you were just 
reading, i.e., the active window.  It 
includes those cc’d and bcc’d.

Reply All with Text -<shift>-<option>-⌘
R

Creates a reply along with the text of the
incoming message you were just reading
to all recipients, including those cc’d 
and bcc’d.

Forward none Creates a message containing the text 
from the incoming mail message you 
were just reading, i.e.,the active window.

Refile none Allows you to file a mail message into a 
different box.

Delete none Deletes an empty mailbox.

Retrieve none “Un-deletes” a mail message.

Insert File... none Allows you to include the text from 
another text file in front of where the 
cursor is positioned.

Enclose Binhex none Allows you to include a binary file with a
message.
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Address Menu 
Selection

Key Equiv. Function

Select Addresses -L⌘ Allows you to select e-mail addresses 
from your address book and insert in the
header section of a message you are 
creating.

Expand Addresses -E⌘ Expands recipient names in a message 
you are creating to include their e-mail 
addresses.

Edit Addresses none Allows you to add and remove entries 
from your address book.

Server Menu 
Selection

Key Equiv. Function

Send Message none Sends a mail message you’ve created 
and closes the window.

Send Outbox none Sends all outgoing messages in the 
outbox.  If you hold down the <option>
key and select Send Outbox, it will send 
the Outbox and Get Mail.

Get Mail -M⌘ Retrieves incoming mail waiting for you 
on the post office server and transfers it 
to the inbox on your Macintosh.

Check Mail -K⌘ Queries the post office server as to 
whether you have any incoming 
messages waiting for you.

Directory -D⌘ Queries the MIT On-Line Directory for 
the specified person’s e-mail address 
and other directory information.

Finger none Requests specified user’s information 
from a specified host.
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Windows Menu 
Selection 

Key Equiv. Function

Next Window none Activates the next window.

Window “x” none Activates the next window with title “x”.
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